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Congratulations on your purchase!

        Diamond Engineering’s Desktop Antenna Measurement System has been designed to aid in the 
testing and development of small to medium sized antennas. Using our state of the art software, this 
system enables you to make many different types of measurements with complete user-definable 
configuration settings. The “Advanced Processing” features enable you to not only plot 3D graphs 
of the measurements, but also to save and recall those measurements for future use or comparison. 
Using the “Group Delay” function, you can calculate the exact distance to the test Antenna, identify 
multi-path rays, and eliminate the need for other measuring devices.  Our software also allows you 
to export your data to a 3rd party application or spreadsheet. 

        This manual will fully assist you with the assembling and configuring as well as teach you how 
to utilize the many features of your Desktop Antenna Measurement System. To achieve the full 
functionality of the rotator system, it’s expected the user has some working knowledge about the 
concepts and theories involved in microwaves and antenna design development. 

        We cannot emphasize the importance of fully reading and understanding this manual enough 
before actually using the equipment, as to avoid damaging the unit and/or possibly voiding your 
warranty.

								        Best regards,

								        The Diamond Engineering Team
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System Overview

Key Features

5000, 6000 and 7000 Models
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Key Features

Light Weight
Platform is made of high quality, light weight Acrylic 
material for easy portability.

Easy USB Connectivity
Unit easily connects to the computer using a 
standard USB cable. 

User Friendly Software
Our software has been designed to be understood 
easily to ensure the shortest time to successful 
antenna measurement. 

High Quality Components
The antenna measurement platform is built mostly 
with non-metallic, custom machined parts.

Widely Compatible
Our software supports a wide range of network 
analyzers and instruments that use the GPIB / 
488.1/2 and SCPI  methods of communication. TCP/
IP and USB is supported on some instruments.

Phase/Angle Measurement
DAMS can measure any vector S-parameter over 
a specified frequency range, at each measurement 
point, using a VNA.

Dual-Axis Movement
360 degrees of horizontal motion at 1/8th degree 
per measurement and +/- 45 degrees vertical 
movement angle at 1 degree per step. 

DC to 8, 18, 40  GHz. Measurement Ranges
Our wide frequency range allows for a diversified 
gamut of compatible antennas. (model dependent)

Rotary SMA Joint
Our high-performance rotary joint enables accurate 
measurements without jeopardizing signal integrity.

Advanced Data Processing Features
Designed for post measurement 
processing you can perform a range of 
functions such as:  
•	 3D visualization for all frequencies 

and angles 

•	 Azimuth and elevation plots for true 
3D data modeling 

•	 Save / recall data sets from RAM or 
local disk 

•	 Group delay (distance calculation) 

•	 Excel-based reports with data 

•	 Efficiency, radiation resistance, and 
AUT loss 

•	 4-trace 2D-plots 

•	 Spherical 3D-plots 

•	 Gain plots 

•	 Simultaneously manipulate 4 
different data sets 

•	 Map over 50,000 measurement 
points into a single 3D-chart 

•	 Reference antenna import feature 

•	 3-point gain substitution, and path 
loss correction methods 

•	 Path loss calculator 

•	 Calculator for modifying 
measurement results and comparing 
antennas 

•	 Exports data to spreadsheet or 3rd 
part application (such as MatLAB) 

•	 Dipole Link Simulator allows creation 
of simulated dipole antennas
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  NOTE:	 For the most updated list of supported instruments, please visit:  
			   http://www.DiamondEng.net/dams-software-studio/supported-instruments

Supported Instruments

Instruments currently supported by Antenna Measurement Studio v5.9:

•	 AMD / Intel (Core i5 recommended)
•	 4 GB RAM
•	 3 GB hard disk space 
•	 1 available USB port
•	 1024 x 768 minimum display resolution
•	 Keyboard and mouse 
•	 Compatible Network Analyzer or Power Meter/Spectrum Analyzer and Signal Generator
•	 PCI, USB or PC Card based name brand GPIB adapter (OR Ethernet if supported)
•	 Printer is optional but helpful for printing measured antenna plots 

System Requirements

VECTOR NETWORK ANALYZERS
Copper Mountain / Planar 2 Port VNA’s
HP / Agilent 8510x Series 
HP / Agilent 8714 Series
HP / Agilent 8720 Series
HP / Agilent 8753 Series 
Agilent 507x Series
Agilent N5320A Series PNA’s
Agilent 836x Series PNA’s
Anritsu 46xx Series Analyzers (Scorpion)
Anritsu 37xx Series Analyzers (Lightning)
Rohde & Schwarz ZVx Series

SIGNAL GENERATORS
HP 83650 Series
HP 8350 Series
SMP Series 

POWER METERS
Elva DPM-10 
HP436A
HP437B
Anritsu, ML2438A
	
SPECTRUM ANALYZERS
HP8565 Series
Rohde & Schwarz FSL Series
Anritsu, MS27xx Series
Anritsu, MT82xx Series 
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Overview

The USB Platform Controller unit is an extremely accurate microprocessor-based stepper 
controller.  Movement signals are sent from the measurement PC to the controller unit 
where precision stepping sequences are generated. A development kit is included which 
enables you to write your own custom software to control the platform.

Front View

Top View

Platform Controller Unit
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x000 Series Assembly, Installation & Configuration

DAMS x000 Series
Instructions for assembly, installation and software configuration
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Main Components 

Use the checklist below to verify all pieces are present and undamaged:

Package Contents

1.	  Positioner Platform                                                    

2.	  Tripod

3.	  Vertical assembly

4.	  Vertical spacer

5.	  Vertical actuator rod

6.	  90 degree pivot **

7.	  USB Platform Controller                           

8.	  Hex wrench tools (SAE and metric)

9.	  110/220v power supply w/ AC cord

10.	 USB cable

11.	 Laser alignment tool **

12.	  Two 10’ ultra-low-loss cables * 

 (SMA male-to-male) 

13.	  Platform control cables

14.	  Digital inclinometer **

*  DAMS 5000 includes low-loss cables

**  Discontinued (replaced by FSM)
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Introduction

	 BEFORE YOU BEGIN:  Unpack ALL items and ensure there are no damaged or missing parts. 

  NOTE:	 The x000 Series is designed for non-FSM measurements using elevation motor.  	
			 

Vertical Assembly

1.	 Unfold tripod and extend the top half-way, then secure the height adjustment. (Fig. 1) 

2.	 Take the grey vertical spacer and snap it onto the very top of the tripod neck. (Fig. 2)		
	

	 IMPORTANT: Without this piece, your unit will not make accurate vertical measurements. 

3.	 Attach the vertical assembly onto the top of the tripod using the included hex wrench so the top 		
	 edge of the vertical assembly is touching the bottom edge of the vertical spacer. (Fig. 3)

Fig. 1 Fig. 2 Fig. 3

Extend tripod Attach vertical spacer

Attach vertical assembly 
ensuring vertical actuator rod 
does not hit tripod legs as it 

moves down

(Continues on next page...)

Assembly & Installation (Non-FSM) 
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Attaching Optional Thrust Plate

1.  Ensure the azimuth setting on the 	
tripod is unlocked.

2.  Place the tripod head in a horizontal 
position and tighten the locking screw.

3.  Align the colored tape on the platform 
with the tape on the tripod head and 
insert the platform into the head at a 30° 
angle.  The head will automatically lock 
the platform into position.

4.  Loosen the tilt lock screw (see Img. 2) 
allowing  the platform to tilt.  Connect the 
vertical actuator rod to the platform and 
tighten the locknut while holding the hex 
shaft using a wrench, ensuring the rod does 
not disconnect.

Instructions

Applies to acrylic and aluminum models only.

The thrust plate attaches using the four 10-32x1/4” 
screws. Do not overtighten screws. If using your own 
screws, be careful not to hit the metal bearing below.
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Hardware Setup
	
1.	 	Setup the tripod and extend the neck upwards about 14”.  

2.	 	Carefully thread the DAMS positioner onto the tripod.  

3.	 	Remove 2 of the 4 thrust plate screws to make room for the FSM mount. 

4.	 	Attach the FSM to the top of the DAMS positioner using the included screws as shown in 
the attached pictures.  The mount is adjustable to allow you to “phase center” the antenna 
on the Elevation/Vertical Axis. 

5.	 Connect the cables as shown in the photos above.

  NOTE:	 The support struts shown in the photo are not required.  We’ve since updated 	
			   with a thicker bottom plate to minimize/eliminate flexing. 

Software Setup

Click “Configure Positioner” and ensure USB/Serial is selected. Place a check-mark in the FSM 
box. Press save, then “restart with default extents”  When you restart the software, you will see 
the updated positioner picture.

Assembly & Installation (with FSM-5) 

 IMPORTANT: For FSM-10 installation, please refer to the separate FSM-10 installation manual.
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Cable Checklist

You should have received the following five cables with your DAMS System:

Two (2) 10-foot RF Cables SMA/2.92mm/2.4mm/ or V 1.85mm cables (or optional 20-
foot cables)
One (1) USB cable (USB to Micro-USB)
Two (2) 6-meter platform control cables

Cable Connections

  NOTE:	 For FSM-5 connections, see photo on Page 11.

Step 1	 Connect USB cable to Platform Controller but DO NOT connect to PC.

Step 2	 Connect the power supply wire to the Platform Controller. 

Step 3	 Connect one end of calibrated SMA cable to bottom of platform. 

Step 4	 Attach other end of SMA cable to VNA. 

  CAUTION:  USE CARE!  Damaged cables will compromise results!

Step 5	 Connect straight end of the yellow cable with the black band on the 		
			   connector to the “Horizontal” port on Platform Controller and 		
			   non-banded cable to “vertical” port. 

Step 6	 Connect other ends of yellow cables to platform. The banded rightangle 	
			   connector connects to turntable, and the non-banded connector 		
			   connects to vertical actuator.

Attaching the Cables
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Software Installation & Configuration

Software Installation

	IMPORTANT:	 Administrator privileges are required to install software.

1.	 Place CD in CD-ROM or Insert Flash Drive, Navigate to drive and launch setup.exe
2.	 Click Next/OK through all setup screens.
3.	 Agilent Runtime and I/O libraries Setup will launch.  
	 Windows 10 Users: you will receive an error that the operating system is not 	
	 supported - ignore this error.
4.	 To verify installation is complete click Start Menu → Programs and ensure the 		
	 folders below are present.  If so, you may launch Antenna Measurement Studio.
 
		  - Agilent Vee Pro Runtime 9.3
		  - Agilent I/O Libraries
		  - DAMS

 NOTE:	 If any folders are missing, an installation error occurred.  Manually install 	
			   components by following instructions below.

Post Installation Instructions

A few extra steps are REQUIRED after the software has been installed

Microsoft Excel 	 Open Excel, go to File → Options and set the default number of 	
				    sheets to 3

Matlab 3D Plots 	 Go to C:\Program Files (x86)\Agilent\Vee Pro Runtime 9.3 		
				    and right click on veerun.exe.  Select the compatability tab and 	
				    select “Run as Administrator”

Entering Your License Key

1.	 In main screen of DAMS software, at the top of the screen, Under “DEMO LICENSE”, 	
	 press “sysetm options” and select LICENSE INFO (not simulator license)
2.	 Enter the license key located on the CD holder or on the front or back of your users 	
	 manual Press “Verify and Save”. 
3.	 Key has been verified should appear.  Click “QUIT” and restart the 			 
	 software to update the license.

License Problems?

E-mail us at Support@DiamondEng.net or call (530) 626-3857 Monday - Friday, 9:00 
A.M. to 5:00 P.M. (PST).
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Controller Setup & USB Driver Installation

Connecting Controller and Installing USB Drivers - (USB / USB-RS232)

1.	 Connect DAMS Platform Controller to computer via USB Cable. A window should 	
	 appear indicating a new device has been found.

	IMPORTANT:  When possible, always allow Windows to check for updated driver.

2.	 If Windows cannot find the driver, Check the box labelled “Search Manually” then 	
	 click “Next”.
3.	 Select c:\DAMS\driver (if windows does not accept this driver go to  
	 http://www.ftdichip.com and download the latest VCP drivers.)
4.	 A new window should pop up indicating another device has been found.  Allow 		
	 Windows to search for an updated driver if you did before.  If not, repeat these 		
	 steps. 

Configuring DAMS Software for x000 Series Positioners

1.	 Start the DAMS software

2.	 Click the “Positioner Settings” button

3.	 Select the USB/Serial option in the upper right from the “Select Controller” pull
	 down. Click the “Find” button, which should find your controller (NOTE: the 		
	 controller must be on a COM port lower than COM8.  If it is not, please configure 	
	 the USB/Serial adapter via Control Panel → Device Manager → Ports → COM & LPT.) 

4.	 Set “Motor Res” to .1125 and gear ratio to 14.4 on both AZ and EL fields.  

5.	 The USB controller configuration is now complete. If no controller is found, follow 	
	 the troubleshooting instructions below. (NOTE: the COM port must me 9 or lower 	
	 for the software to communicate with the controller, this can be changed in 		
	 device manager)

6.	 Press “SAVE” button, followed by “QUIT’ to save changes. Restart software.

Troubleshooting

1.	 Check all connections between Controller and PC

2.	 Click Start → Control Panel → System → Hardware Tab → Device Manager 

3.	 Expand section labeled Ports Com&LPT.  DAMS Platform controller should be		
	 listed with an associated COM Port.  If no controller is listed, re-install the driver. 		
	 Please contact us if you need any assistance.
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Calibrating Vertical Movement to Zero Degrees

	IMPORTANT:	 For the software to move the platform correctly on the vertical 	
				    axis you must have the platform at zero degrees when starting 	
				    the DAMS Software, or the platform must match the vertical 		
				    position shown in the software before moving vertically. 

IF THE PLATFORM ANGLE AND SOFTWARE ANGLE DO NOT MATCH:
Use the Jog +/-  pull-downs to move the platform to the level position.  Once you have 
reached the desired position, press “ZERO POSITIONER” to set the current physical 
position as “0,0”. 

  NOTE:	 If you exit the software without returning to zero, you must follow the 	
			   above instructions to once again re-set the positioner to zero degrees.

Verifying Positioner Connectivity and Operation

These steps will assist you with verifying the x000 Series positioner’s operation with the 
DAMS software.  All steps for installing and configuring the software and connecting 
cables should be completed before performing the following steps. 

1.	 Ensure power supply is plugged in and start the DAMS Software.

2.	 Elevation / Vertical Movement Test 
	 Select -45 from “El jog to” (See image below) pull-down - positioner should tilt 		
	 45 degrees towards reference antenna.  Select +45 from “El jog to” pull-down and 	
	 positioner should tilt 	 all the way to +45 degrees. 

3.	 Azimuth / Horizontal  Movement Test 
	 Select 180 from “Az jog to” pull-down.  Positioner should rotate 180 degrees of 		
	 reference antenna.  Select 360 from “Az jog to” pull-down and positioner should 		
	 finish the rotation to 360 degrees.  (See image below)

4.	 Resetting to 0, 0 Degrees
	 After completing the tests, click  to clear all position settings and 	
	 move the positioner to 0 degrees azimuth and 0 degrees elevation.

Testing and Calibration Complete  

Proceed to the Antenna Measurement Studio 
Installation chapter to complete the installation 
and begin making measurements.

Unit Calibration & Positioner Verification (non-FSM)  
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Plate Drawing

Use the drawing below to help design fixtures to mount on your DAMS system.
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x100 Series Assembly, Installation & Configuration

DAMS x100 Series
100-pound capacity positioner with an extra heavy duty tripod 

and measuring capabilities frequencies of up to 40 GHz



18x100 Installation & Configuration

Main Components

Upon receiving your shipment of the DAMS x100 series, please verify you’ve received 
all items below while checking for any damages that may have occurred during the 
shipment process.  Please contact us immediately if any missing or damaged items. 

1.	  100 pound positioner                                                    

2.	  Two 10-foot ultra low loss cables

3.	  Separate power and control cables

4.	  Tripod adapter plate

5.	  USB to RS232 Adapter

6.	  USB cable

7.	  24v power supply                         

8.	  Hex wrench tools (SAE)

9.	  SMA saver, additional hardware      

10.	 Digital level

11.	 Laser alignment tool ** 

12.	 Heavy duty tripod

13.	 Thrust plate

14.	 DAMS Manual & Software CD 
(not shown)

Package Contents
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Assembly Steps

	 CAUTION:  Damaging any SMA connectors during assembly may result in faulty readings.

	 BEFORE YOU BEGIN:  Unpack all items and ensure there are no damaged or missing parts. 

1.	 Lay the positioner on its side and attach the Tripod Adapter Plate to the bottom using the four 	
	 Hex-Cap Screws and included hex wrenches. Use the blue marks for proper orientation. (Fig. 1)

2.	 Unfold and stand up the tripod, then loosen the height lock and crank the height up to about 2 	
	 inches. (Fig. 2)

3.	 Place the positioner on the tripod by holding it upright and sliding the shaft on the adapter plate 	
	 into the hole in the top of the tripod neck.  Rotate the assembly until you can fit the red-handled 	
	 hex wrench into the set screw located inside of the hole.  Tighten the set screw and the positioner 	
	 now should be securely mounted onto the tripod. (Fig. 3)

Tripod & Positioner Assembly

Fig. 1 Fig. 2

Fig. 3
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Attaching the Cables

1.	 Attach the control/power cables to the side of the positioner. (Fig. 1)

2.	 Connect the USB cable and white cable from control cable to USB 			 
interface, DO NOT connect to PC yet.  (Fig. 2) 

3.	 Connect power supply to power cable (Fig. 3)

4.	 Connect precision RF cable to positioner.  Tighten but do not over-torque. (Fig. 4)

5.	 Connect other side of RF cable to ports 1 or 2 of test equipment. (Not shown)

Fig. 1 Fig. 2

Fig. 3 Fig. 4

(ACTUAL UNIT MAY VARY)  
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Assembly Steps

  NOTE:	 This section is related to the DAMS 6100 positioner ONLY.  The 6100 positioner 		
			   follows the same procedures as the original 5000, 6000, or 7000 positioners with		
			   exception to a few key items.

The positioner is tracked using internal, absolute encoders at zero degrees so the positioner will 
always be in the same position.

Before making any measurements, ensure the positioner is at 0 degrees azimuth and 0 degrees 
elevation by using the  button in the software.  Attach your antenna to the 
positioner, ensuring it is properly oriented to the fixed reference antenna.  The pictures below show 
the orientation of the positioner for the given position settings.  When making a scan measurement 
(horizontal and vertical) the positioner will move from 0 to 360 degrees for the first cut.  The 
positioner will then tilt and scan back from 360 degrees to 0 degrees.  It will continue this pattern of 
motion until the measurement is complete.

POSITIONER EXAMPLE: ELEVATION / TILT

-90 degrees elevation

+90 degrees elevation
0 / 360 degrees azimuth

+90 degrees elevation
90 degrees azimuth

+90 degrees elevation
180 degrees azimuth

0 degrees elevation +90 degrees elevation

POSITIONER EXAMPLE: AZIMUTH / PAN

Using the DAMS 6100 Positioner
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Movement

Resolution: 			   0.1 degree both axis (6100/7100 models)
					     0.25 degree (5100 models) 
Horizontal / Azimuth:		 0 to 360 degrees
Vertical / Elevation:		  -90 to +90 degrees
Horizontal / Az. torque:	 50 ft-lbs.
Vertical/Elev. Torque:		  150 ft-lbs.
Drivetrain: 			   Precision worm drive with roller bearings
Weight Capacity: 		  100 lbs.

Electrical

Volts:			   24 VDC
Amps: 			   2.3
Interface: 			   RS232 w/USB converter

RF Connectivity

Frequencies: 			   DC-6 GHz (5100 model)
					     DC-18 GHz (6100 model)
					     DC-40 GHz (7100 model) 
Rotary DUT connector: 	 SMA Female
Stationary Connector: 	 SMA Female
Rotary Joint: 			   S.I.C based coaxial rotary joint

Physical Specifications

Material: 			   Powder-coated aluminum
Weight : 			   44 lbs. (20 kg) 
Height: 			   12.51” (31.8 cm)
Width:  			   12.61” (32 cm)
Depth:  			   8.87” (22.5 cm)

Tripod Specifications

Material:			   Aluminum and ABS 
Weight: 			   23 lbs. (10.4 kg)
Height Min: 			   33.5” (85 cm)
Height Max: 			   70” (178 cm)
Maximum Spread: 		  73” (185 cm)
Collapsed Dimensions: 	 40.5” x 12.5” (102 x 31.3cm)
Leg Sections: 			   2
Column Travel: 		  18” (45 cm) 
Foot Plate Diameter: 		 4” (10 cm) (self-leveling 5/8” hole for spiking)

Positioner & Tripod Specifications
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Positioner Troubleshooting

Possible Problems & Solutions

The DAMS x100 Series Positioner is a very robust and stable positioner. In the event that you believe 
you may have a problem with your positioner. Please check the items below. If you do not see your 
problem listed below or you are not able to get your problem resolved, please contact us and we will 
be happy to assist you with your problems. 

Problem: 		  Software message is displayed that the positioner has  reached its limit.
Possible Cause: 	 The Horizontal or Vertical tracking may be out of sync in the software? 
Solution: 		  Restart software and press  button to reset all settings.

Problem: 		  When instructed to move, the positioner does nothing.
Possible Cause:	 Power is not connected? Wrong port selection? Software glitch?
Solution: 		  Check all cables, reboot PC, disconnect and reconnect positioner power. 
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Software Installation & Configuration

Software Installation

	IMPORTANT:  Administrator privileges are required to install software.

1.	 Place CD in CD-ROM.  Setup should start automatically.  If setup does not, click:
	 Start Menu → Run → Browse, and locate SETUP.EXE in the CD-ROM.

2.	 Click Next/OK through all setup screens.

3.	 Agilent Runtime and I/O libraries Setup may also launch.  If so, install as well.

4.	 To verify installation is complete click Start Menu → Programs and ensure 		
	 the folders below are present.  If so, you may launch Antenna Measurement Studio.
 
		  - Agilent Vee Pro Runtime 8.0
		  - Agilent I/O Libraries
		  - DAMS

 NOTE:	 If any folders are missing, an installation error occurred - manually install 	
			   components by following instructions below.

Manually Installing Runtime / IO Libraries

Antenna Measurement Studio is dependent on the application below.  It is normally 
installed during setup, but can fail in certain situations.  In this event, run this setup file 
individually:

Agilent I/O Libraries	 Start Menu → Run c:\DAMS\runtime\iolib\Setup.exe 
					     (or launch from CD menu)

Entering Your License Key

1.	 In main screen of DAMS software, at the top of the screen, next to “DEMO LICENSE”, 	
	 press “?”.

2.	 Enter the license key located on the CD holder (in the back of the users manual), or 	
	 from the back of the users manual itself.  Press “Verify and Save”. 

3.	 Notification key has been verified should appear. Next, click “QUIT” and restart the 	
	 software to update the license.

License Problems?

E-mail us at Support@DiamondEng.net or call (530) 626-3857 Monday - Friday, 9:00 
A.M. to 5:00 P.M. (PST).
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USB Driver Installation & Configuration

Installing the USB Driver 

	IMPORTANT:	 If you ordered a pre-configured PC, you do NOT need to perform 	
				    any of these steps unless you are re-installing the system. 

Antenna Measurement Studio should be installed before performing the steps below.

1.	 Connect DAMS Platform Controller to PC using included USB cable.  Notification 		
	 indicating a new device has been found should appear.  Allow windows to check for 	
	 a driver automatically.  If no internet connectivity or Windows cannot 			 
	 find driver, still proceed with steps 2-5.

2.	 Check the box labelled “Search Manually” and click “Next”.

3.	 Select CD-ROM, click “Next” 

4.	 Notification may appear that driver has not passed the WHQL certification. Click 		
	 “Continue Anyway”.  Click Finish.   

5.	 New notification indicating another device has been found should appear. Allow 		
	 Windows to search for a driver if it was successful the first time.  If not, repeat steps 	
	 2-5 above. 

6.	 Open up Control Panel (Start→ Settings → Control Panel), and open System. (If 		
	 using category view, you must click “Performance and Maintenance” before you can 	
	 open System).  Open the Hardware tab and click on “Device Manager”  

7.	 Click the “+” sign next to “Ports COM&LPT”, and the controller will listed as “USB 		
	 Serial Port”.  Make note of the port number it shows.

Configuring DAMS Software for x100 Series Positioners

1.	 In Antenna Measurement Studio, click “Positioner Settings”.

2.	 Select the x100 series from the “Interface” pull down menu.

3.	 Select the COM port that you previously noted from the “Port” pull down menu.

4.	 Under the x100 pull down menu, select your model. 

5.	 Set “Gear Ratio” to 10.

6. Change “Motor Res.” to 2.5 for 5100 Systems, or 1 for 6100 and 7100 models.

7. Press the “SAVE” and “QUIT” buttons to save settings and quit.
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Calibrating Vertical Movement to Zero Degrees

	IMPORTANT:	 For the software to move the platform correctly on the vertical 	
				    axis you must have the platform at zero degrees when starting 	
				    the DAMS Software, or the platform must match the vertical 		
				    position shown in the software before moving vertically. 

IF THE PLATFORM ANGLE AND SOFTWARE ANGLE DO NOT MATCH:
Use the Jog +/-  pull-downs to move the platform to the level position.  Once you have 
reached the desired position, press “ZERO POSITIONER” to set the current physical 
position as “0,0”. 

  NOTE:	 If you exit the software without returning to zero, you must follow the 	
			   above instructions to once again re-set the positioner to zero degrees.

Verifying Positioner Connectivity and Operation

These steps will assist you with verifying the x100 Series positioner’s operation with 
the DAMS software.  All previous steps for installing and configuring the software and 
connecting cables should be completed before performing the following steps. 

Step 1	 Ensure all cables are connected and power supply is plugged in. 

Step 2	 Start the DAMS Software.

Step 3	 Elevation / Vertical Movement Test 
			   Select -90 from “El jog to” pull-down - positioner should tilt 90 degrees 	
			   towards reference antenna.  Select +90 from “El jog to” pull-down.  		
			   Positioner should tilt all the way to +90 degrees.  (See image below)

Step 4	 Azimuth / Horizontal  Movement Test 
			   Select 180 from “Az jog to” pull-down.  Positioner should rotate 180 		
			   degrees of reference antenna.  Select 360 from “Az jog to” pull-down.  	
			   Positioner should finish the rotation to 360 degrees.  (See image below)

Step 5	 Resetting to 0, 0 Degrees
			 
			   Click  which clears all position settings, and 	
			   moves the positioner to 0 degrees azimuth and degrees elevation.

Testing and Calibration Complete  

Proceed to the Antenna Measurement Studio 
Installation chapter to complete the installation 
and begin making measurements.

Unit Calibration & Positioner Verification
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x250 Series Assembly, Installation & Configuration

DAMS x250 Series
250-pound capacity positioner with an extra heavy duty tripod 

and measuring capabilities frequencies of up to 40 GHz
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Package Contents

Main Components

Upon receiving your shipment of the DAMS x100 series, please verify you’ve received 
all items below while checking for any damages that may have occurred during the 
shipment process.  Please contact us immediately if any missing or damaged items. 

1.	  x250 Series Positioner                                                  

2.	  Two 10-foot ultra low loss RF cables

3.	  Power and control cables

4.	  Tripod adapter plate

5.	  USB to Serial Converter cable

6.	  48v power supply (exact model may vary)                         

7.	  Hex wrench tools (SAE)

8.	  SMA saver, additional hardware      

9.	  Digital level

10.	 Laser alignment tool 

11.	 Heavy duty tripod

12.	 Thrust / mounting plate (not shown)

13.	 DAMS Manual & Software CD (not shown)
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Assembly Steps

	 CAUTION:  Damaging any SMA connectors during assembly may result in faulty readings.

	 BEFORE YOU BEGIN:  Unpack all items and ensure there are no damaged or missing parts. 

1.	 Unfold tripod, Remove Threaded ring from adapter plate (Fig. 1)

2.	 Place the adapter plate onto the tripod- Ensure keys on adapter plate match with the tripod 
     Then replace the threaded ring to lock the adapter to the tripod (Fig. 2)

3.	 Have another person assist placing the x250 unit on top of the tripod, use the alignment mark to
	 help line up the bolt holes. Use the included hardware to attach the x250 unit.   (Fig. 3)

Tripod & Positioner Assembly

Fig. 1 Fig. 2

Fig. 3
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Attaching the Cables

1.	 Attach the power and control cables to the side of the positioner. (Fig. 1)

2.	 Connect the USB adapter to the Serial End of the control cable (Fig. 2) 

3.	 Connect Power cable to the power supply (Fig. 3)

4.	 See page 36 for USB adapter installation and software configuration 

Fig. 1 Fig. 2

Fig. 3

`
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(x100 Model Shown)  

Operation Tips

 NOTE:	 This section is related to the x250 positioner ONLY.  The x250 positioner 			 
		  follows the same procedures as the original 5000, 6000, or 7000 positioners with			 
		  exception to a few key items:

The units positioner is tracked using internal, absolute encoders at zero degrees so the positioner 
will always be in the same position, no zeroing is required

Before making any measurements, ensure the positioner is at 0 degrees azimuth and 0 degrees 
elevation by using the  button in the software.  Attach your antenna to the 
positioner, ensuring it is properly oriented to the fixed reference antenna.  The pictures below show 
the orientation of the positioner for the given position settings.  When making a scan measurement 
(horizontal and vertical) the positioner will move from 0 to 360 degrees for the first cut.  The 
positioner will then tilt and scan back from 360 degrees to 0 degrees.  It will continue this pattern of 
motion until the measurement is complete.

POSITIONER EXAMPLE: ELEVATION / TILT

-90 degrees elevation

+90 degrees elevation
0 / 360 degrees azimuth

+90 degrees elevation
90 degrees azimuth

+90 degrees elevation
180 degrees azimuth

0 degrees elevation +90 degrees elevation

POSITIONER EXAMPLE: AZIMUTH / PAN

Using the x250 Positioner
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Movement

Resolution: 			   0.01 degree both axis
Horizontal / Azimuth:		 0 to 360 degrees
Vertical / Elevation:		  -90 to +90 degrees
Vertical/Elev. Torque:		  500 ft-lbs.
Drivetrain: 			   Precision worm drive with roller bearings
Weight Capacity: 		  250 lbs.

Electrical

Volts:			   48 VDC
Amps: 			   6
Interface: 			   RS232 w/USB converter

RF Connectivity

Frequencies: 			   DC-6 GHz (5250model)
					     DC-18 GHz (6250 model)
					     DC-40 GHz (7250 model) 
Rotary DUT connector: 	 SMA Female
Stationary Connector: 	 SMA Female
Rotary Joint: 			   S.I.C based coaxial rotary joint

Physical Specifications

Material: 			   Powder-coated aluminum
Weight : 			   125lbs. (20 kg) 
Height: 			   18” (45.7cm)
Width:  			   20” (50.8 cm)
Depth:  			   12.5” (31.75 cm)

Tripod Specifications

Material:			   Aluminum and ABS 
Weight: 			   22 lbs. (10 kg)
Height Min: 			   25” (63.5 cm)
Height Max: 			   41” (104 cm)
Maximum Spread: 		  55” (139.7 cm)
Collapsed Dimensions: 	 40.5” x 12.5” (102 x 31.3cm)
Leg Sections: 			   2
Foot Plate Diameter: 		 6” (15.2 cm) (self-leveling 5/8” hole for spiking)

x250 Positioner & Tripod Specifications
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x250 Thrust Plate / Mounting Plate Drawing

Units: Inches
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Positioner Troubleshooting

Possible Problems & Solutions

The DAMS x100 Series Positioner is very robust and stable.  If you believe you may have a problem, 
please check the items below.  If you do not see your problem listed below or you are not able to 
get your problem resolved, please contact us and we will be happy to assist you. 

Problem: 		  Software message is displayed that the positioner has  reached its limit.
Possible Cause: 	 The Horizontal or Vertical tracking may be out of sync in the software? 
Solution: 		  Restart software and press  button to reset all settings.

Problem: 		  When instructed to move, the positioner does nothing.
Possible Cause:	 Power is not connected? Wrong port selection? Software glitch?
Solution: 		  Check all cables, reboot PC, disconnect and reconnect positioner power. 

If the solutions above do not help, please contact us at (530)626-3857
or email us at support@diamondeng.net
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Software Installation & Configuration

Software Installation

	IMPORTANT:  Administrator privileges are required to install software.

1.	 Place CD in CD-ROM.  Setup should start automatically.  If setup does not, click:
	 Start Menu → Run → Browse, and locate SETUP.EXE in the CD-ROM.

2.	 Click Next/OK through all setup screens.

3.	 Agilent Runtime and I/O libraries Setup may also launch.  If so, install as well.

4.	 To verify installation is complete click Start Menu → Programs and ensure 		
	 the folders below are present.  If so, you may launch Antenna Measurement Studio.
 
		  - Agilent Vee Pro Runtime 8.0
		  - Agilent I/O Libraries
		  - DAMS

 NOTE:	 If any folders are missing, an installation error occurred - manually install 	
			   components by following instructions below.

Manual Installation Instructions

Antenna Measurement Studio is dependent on the application below.  It is normally 
installed during setup, but can fail in certain situations.  In this event, run this setup file 
individually:

Agilent I/O Libraries	 Start Menu → Run c:\DAMS\runtime\iolib\Setup.exe 
					     (or launch from CD menu)

Entering Your License Key

1.	 Press “System Options” in the upper left corner of the software then select 
	 “license info” 

2.	 Enter the license key located on the CD holder (in the back of the users manual), or 	
	 from the back of the users manual itself.  Press “Verify and Save”. 

3.	 Notification key has been verified should appear. Next, click “QUIT” and restart the 	
	 software to update the license.

License Problems?

E-mail us at Support@DiamondEng.net or call (530) 626-3857 Monday - Friday, 9:00 
A.M. to 5:00 P.M. (PST).
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USB Driver Installation & Configuration

Installing the USB Driver 

	IMPORTANT:	 If you ordered a pre-configured PC, you do NOT need to perform 	
				    any of these steps unless you are re-installing the system. 

Antenna Measurement Studio should be installed before performing the steps below.

1.	 Connect DAMS Platform Controller to PC using included USB cable.  Notification 		
	 indicating a new device has been found should appear.  Allow windows to check 	
	 for a driver automatically.  If no internet connectivity or Windows cannot 		
	 find driver, still proceed with steps 2-5.

2.	 Check the box labelled “Search Manually” and click “Next”.

3.	 Select CD-ROM, click “Next” 

4.	 Notification may appear that driver has not passed the WHQL certification. Click 		
	 “Continue Anyway”.  Click Finish.   

5.	 New notification indicating another device has been found should appear. Allow 		
	 Windows to search for a driver if it was successful the first time.  If not, repeat steps 	
	 2-5 above. 

6.	 Open up Control Panel (Start→ Settings → Control Panel), and open System. (If 		
	 using category view, you must click “Performance and Maintenance” before you can 	
	 open System).  Open the Hardware tab and click on “Device Manager”  

7.	 Click the “+” sign next to “Ports COM&LPT”, and the controller will listed as “USB 		
	 Serial Port”.  Make note of the port number it shows.

Configuring DAMS Software for x250 Series Positioners

1.	 In Antenna Measurement Studio, click “Positioner Settings”.

2.	 Select the x100 series from the “Interface” pull down menu.

3.	 Select the COM port that you previously noted from the “Port” pull down menu.

4.	 Under the x100 pull down menu, select your model. 

5.	 Set “Gear Ratio” to 10.

6. Change “Motor Res.” to 1

7. Press the “SAVE” and “QUIT” buttons to save settings and quit.
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Unit Calibration & Positioner Verification

Verifying Positioner Connectivity and Operation

These steps will assist you with verifying the x250 Series positioner’s operation with 
the DAMS software.  All previous steps for installing and configuring the software and 
connecting cables should be completed before performing the following steps. 

Step 1	 Ensure all cables are connected and power supply is plugged in. 

Step 2	 Start the DAMS Software.

Step 3	 Elevation / Vertical Movement Test 
			   Select -90 from “El jog to” pull-down - positioner should tilt 90 degrees 	
			   towards reference antenna.  Select +90 from “El jog to” pull-down.  		
			   Positioner should tilt all the way to +90 degrees.  (See image below)

Step 4	 Azimuth / Horizontal  Movement Test 
			   Select 180 from “Az jog to” pull-down.  Positioner should rotate 180 		
			   degrees of reference antenna.  Select 360 from “Az jog to” pull-down.  	
			   Positioner should finish the rotation to 360 degrees.  (See image below)

Step 5	 Resetting to 0, 0 Degrees
			 
			   Click  which clears all position settings, and 	
			   moves the positioner to 0 degrees azimuth and degrees elevation.

Testing and Calibration Complete  

Proceed to the Antenna Measurement Studio 
Installation chapter to complete the installation 
and begin making measurements.
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Antenna Measurement Studio Installation

Antenna Measurement Studio 

Supports a wide range of power meters, voltmeters, spectrum analyzers and 
VNA/PNA’s with many data processing features such as quad trace polar 

plots, dual trace amplitude plots and more
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Instrument Communication

Antenna Measurement Studio communicates with instruments using GPIB, TCP/IP, or 
USB.  This is accomplished using the Agilent I/O Libraries / Connection Expert and the 
Agilent VEE Runtime I/O Configuration, which should be located in your start menu.  
 

 NOTE:	 An entry in the runtime configuration is ALWAYS required even if there 	
			   is nothing configured using the Agilent Connection Expert
 
If using GPIB we recommend one of the adapters listed below:

			   - National Instruments GPIB products (ALL) 
			   - Agilent GPIB products (ALL)
			   - Measurement Computing PCI or PCMCIA GPIB adapters.

 NOTE:	 Using an adapter that is not listed could result in strange behavior and 	
			   installation or configuration issues.
		

Supported Instrument Types

Please see our list of “Supported Instruments” which are compatible with DAMS 
Antenna Measurement Studio.  We have designed the software to work with many 
types of instruments including, but not limited to: 

			   - Vector Network Analyzers		  - Signal Generators
			   - Spectrum Analyzers		  - Power Meters
			   - Voltmeters
 

 NOTE:	 For the most updated list of supported instruments, please visit:  
			   http://www.DiamondEng.net/dams-software-studio/supported-instruments

Instrument Configuration
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Configuring your Instruments

** For Copper Mountain / Planar VNA’s, see next section **

After Antenna Measurement Studio is installed, the following Start Menu folders should exist:

		  - Agilent I/O Libraries 
		  - Agilent VEE Pro (X.X) Runtime

 NOTE:	 If any folders are missing, refer to the software installation for your model.

Step 1:  Find instruments using Agilent Connection Expert 

1.	 Connect and turn on instruments. 
2.	 Click Start → Programs → Agilent I/O Libraries → Connection Expert.
3.	 The Connection Expert will find and display any interfaces and instruments. 
4.	 This step is complete, Exit the Connection expert and proceed to the next section (VEE Runtime 		
	 I/O Configuration)

 NOTE:	 Some GPIB instruments do not support the *IDN command. For example, HP8510 		
			   show up with a red X and say “Communication Failure”, but is not a problem. 

ADDING TCP/IP INSTRUMENTS:  If your TCP/IP instrument was NOT automatically found, you 
must attempt to manually configure it.   To do this, right click on TCP/IP in the list and select “ADD”.  
Then, choose TCP/IP and attempt to manually enter the IP address or hostname of the instrument. 

Agilent Connection Expert & VEE Runtime Configuration
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Step 2. VEE Runtime I/O Name Configuration

	IMPORTANT:	 You must complete the following steps for our software to 		
				    communicate with your instruments.  Antenna Measurement 		
				    Studio will display an error if you do not enter the correct 		
				    instrument name exactly as shown in the list on the following 		
				    page.

1.	 Click Start → Programs → Agilent VEE pro 8.0 Runtime → I/O Config

2.	 Click “Find Instruments”.  (See image above)

3.	 Instrument should appear in the list labeled as “newInstrument”.  (See image above)

4. 	 Clicking “Properties” opens a new 	
	 window (see image to right).		
	 Change “Name” to match the 		
	 one from our list on the next page 	
	 which matches your analyzer. 

5.	 After you’ve entered the 		
	 appropriate name exactly as it is 	
	 shown in the list,  click “Advanced” 	
	 and set the “Instrument Time-Out” 	
	 to 15 seconds. Press “OK” and 		
	 “SAVE”, closing out of both boxes. 
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Step 2. VEE Runtime I/O Name Configuration (continued)

  NOTE:	 Don’t see your instrument?  Contact us, we may have compatible/custom drivers.

Network Analyzers					     “Name” Setting
HP 8510 series analyzers 					     HP8510
HP 8714 series analyzers 					     HP8714
HP 8720 series analyzers 					     HP8720
HP 8753 series analyzers					     HP8753 
HP 8757 Scalar						      HP8757
Advantest R376x Series					     ADVR376X
Agilent / HP 8530						      HP8350 
Agilent 5230A series analyzers				    N5230A
Agilent 5071 series analyzers				    AT5071
Agilent 836x PNA analyzers				    AT8363
Agilent PNA Universal Driver				    AGILENTPNA
Agilent Fieldfox N992x					     N99XX
Anritsu Scorpion Analyzers					    MS462X
Anritsu MS20xx VNA						     MS20XX
Anritsu MT8860C VNA					     MT8860C 
Anritsu S820E							      S820
Anritsu Lightning Analyzers				    ML37XX
Anritsu Vector Star Analyzers				    VSTAR
(Vector Star includes MS46121 and the Shockline Series)	
Copper Mountain S2VNA					     exempt
Rohde & Schwarz RS series					    RSZVR
Rohde & Schwarz ZVH series				    RSZVH
Rohde & Schwarz ZND series				    RSZND
Rohde & Schwarz Planar 304 and 804 series		  exempt
Rohde & Schwarz Planar S5048 series, TR1300 series	 exempt

Signal Generators	
Agilent 33xxx Series Signal Generator			   AT33XXX
Agilent 51XX Series Signal Generator			   N51XX
Agilent 9310A Series Signal Generator			   N9310
Anritsu MG69xx Series Signal Generator 			   MG69XX
Anritsu MG36xx Series Signal Generator			   MG36XX
HP Universal Sig-Gen Driver				    HPGENERATOR 
HP 83650B Signal Generator 				    HP836
HP 8350 Sweep Generator 					    HP8350 
HP 8648 Sweep Generator					     HP8648
Quonset QM2010 Synthesizer				    QM2010
Rohde & Schwarz SMP Series				    RSSMP 
Rohde & Schwarz SML Series				    RSSML 
Rohde & Schwarz SMU Series				    RSSMU
	
Spectrum Analyzers	
Advantest 32XX Series					     ADV32XX
Agilent E440x Series						      E440X
Anritsu MS20xx Series					     MS20XX 
Anritsu MS26xx Series					     MS26XX                        (list continues...)



44Software Installation & Configuration

Step 1: Set DAMS to run as administrator
1.	 	Go to C:\Program Files (x86)\Agilent\Vee Pro Runtime  folder
2.	 	Right Click on VEERUN.EXE  and select properties
3.	 	Click the compatibility tab and place a checkbox in “RUN AS ADMINISTRATOR”
4.	 	Click OK to save settings

Step 2: Install and Start VNA Software
1.	 	 Install the copper Mountain S2 VNA software, IMPORTANT- at the end of the installation be sure 	

to select the option to install COM libraries!!! 
2.	  	Connect the VNA to the PC, the drivers should load
3.	 	Right click on the VNA Software icon, select properties, click compatibility tab and place a 

checkbox in “RUN AS ADMINISTRATOR” then click OK
4.	 	 Start the VNA Software, it should load and connect to the VNA

Step 3: Making a Measurement using DAMS Software
1.	 	Configure the VNA for desired start / stop frequency / number of points 
2.	  	Start the DAMS Software. 
3.	  	From the “Select Instrument” pulldown, select your PLANAR model.
4.	 	 Press settings to configure S21 or S12 Measurement.
5.	 	Calibrate system either using VNA or DAMS Software, see chapter on calibration for details and 

examples.
6.	 	 Press one of the “Measure” buttons, the software should start collecting data and the positioner 

should move.

Copper Mountain / Planar VNA’s -  Installation

Anritsu MT82xx and MS27xx Series				   MS27XX
HP 8565 Series						      HP8565 
Nex 1 NS132 Spectrum Analyzer				    NS132	
Rohde & Schwarz FSL Series 				    RSFSL 
Tektronix 271x Spectrum Analyzer				    TEK271X
	
Power Meters	

Agilent EPM Series						      AGEPM
Agilent / HP 34401A Multimeter				    HP34401
Anritsu ML2438A						      ML2438
Anritsu ML4803A						      ML4803
Boonton 4530							      BN4530 
Boonton 52018						      exempt
ELVA-1 DPM 10						      DPM10
HP 436A Power Meter 					     HP436
HP 437B Power Meter					     HP437
Keithley K2182						      K2182 
Telemakus TED8000-40 USB Power Detector		  TED8000
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Configuration Instructions for option DPA_Autopol automatic polarization switching using 
a USB RF switch. 

Step 1: Install USB switch driver and libraries
1. 		  Install MiniCircuits switch software from the mini-circuits support website.
		

Step 2: Configure DAMS software
1.	 	 Start DAMS antenna measurement studio 

2.	 	Click the “Pol Settings” button and select MiniCircuits Switch from the pull-down-  If an error 
occurs you may not have the libraries installed, please be sure that you are using the latest DLL 
files, repeat the steps in step 1 with current minicircuits software. 

3.	 	 Look on the back of your switch module and note the serial number of the unit.  Enter the serial 
number into the window and press “update and connect” if working properly the switch should 
say “Connected” 

Step 3: Verification Test
1.	 	 From either the settings panel under Pol Setting, or from the main page of the software, pressing 

either H or V should cause the switch to change.

2.	 	 The change cam be seen by the LED indicator located on the front of the switch changing color, 
you will also hear a very slight audible click.  
 
Further information on the Automatic polarization switching  and options can be found under 
the software overview section of this manual 

			 

USB Polarization Switch Installation (DPA-Autopol)
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Configuring Other DAMS Positioners (D6050, DCP252, ETC.)

Other DAMS Positioner Settings 

Detailed positioner setup instructions can be found in the associated manual for the 
particular DAMS positioner. For your convenience, we have listed a number of DAMS 
Postiioner configurations with the Appropriate DAMS Software Settings. 

D6050 Series using MC3B / LC4x Series 3 Axis Series Controllers

Azimuth/Horizontal/Roll  
	 Motor Resolution : .1125
	 Gear Ratio:  
		     Belt Drive: 36  
		     Worm Drive: 72
	 D6050 Checkbox: Selected
	 Full Spherial Mount Checkbox: Selected
	 Start Speed: 1000
	 Stop Speed: 8000
	 Slope: 8 
	 Mini Stepping: ON 
	 Holding Current: ON

D6050 Series using SSXYQE 2 Axis Series Controllers

Azimuth/Horizontal/Roll  
	 Motor Resolution : 1.8
	 Gear Ratio: 144		   
	 D6050 Checkbox: Selected
	 Full Spherial Mount Checkbox: Selected
	 Start Speed: 250
	 Stop Speed: 500
	 Slope: 8 
	 Mini Stepping: ON 
	 Holding Current: ON

Elevation/Vertical/Turntable  
	 Motor Resolution : .1125
	 Gear Ratio:  90
	 D6050 Checkbox: Selected
	 Full Spherial Mount Checkbox: Selected
	 Start Speed: 1000
	 Stop Speed: 8000
	 Slope: 8 
	 Mini Stepping: ON 
	 Holding Current: ON

Elevation/Vertical/Turntable
	 Motor Resolution : 1.8
	 Gear Ratio: 190		   
	 D6050 Checkbox: Selected
	 Full Spherial Mount Checkbox: Selected
	 Start Speed: 250
	 Stop Speed: 500
	 Slope: 8 
	 Mini Stepping: ON 
	 Holding Current: ON



47 Software Installation & Configuration

Configuring a 3rd party positioner (Sunol, Frankonia, M2, Etc)

Sunol ELAZ2B

The Sunol ELAZ2B is a 2-axis positioner with a resolution of 28,800 steps per revolution 
for both Azimuth and Elevation, it is configured by performing the following steps: 

1.	 Start the DAMS Software and press “Positioner Settings”

2.	 Under “Select Controller” select 3rd Party

3.	 Click the Third Party pull-down and select Sunol ELAZ2B

4.	 Manually enter the COM port of the positioner (this can be found in device 
	 manager under PORTS COM&LPT

5.	 For “Motor Resolution” enter .1125” and a gear ratio of 9 for both Azimuth and 
	 Elevation Axis

6.	 Press “SAVE” then select “restart with default extents” 

Use the image below for reference:
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Sunol ELAZ-75 / SC110V GPIB Controller

The Sunol SC100V controller has up to 3 channels which all are have independent GPIB addresses. 
The DAMS software can use up to 2 of these channels (AZ / EL) 

GPIB Configuration

1.	 Verify each axis of the controller is configured for a specific GPIB address and properly configured 
	 for the positioner, is attached to that axis and the gpib adapter is connected to the controller.  		
	 Note which one is AZ and which one is EL. 

2.	 On the computer, open the Agilent/Keysight Connection Expert, the connection expert should 
	 show all of the controllers as active.  Once verifying, close the connection expert. 

3. 	Open Start → Programs → Agilent VEE Pro Runtime → I/O Configuration. 

4. 	Press “FIND” it should ask to send an IDN request to each axis. 

5. 	Once the controllers are found they will have a name like “newinstrumentX” you must change the 
	 names to SC110VCH1 and SC100VCH2. 

6. 	Press the SAVE button then close the I/O Configuration.
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Sunol SC110V GPIB Controller (continued)

DAMS Configuration
 
1.	 Start the DAMS Software and open “Positioner Settings”

2. 	From Select controller choose “Third Party”

3. 	From the “Other positioner” setting choose “SUNOL SC110V”

4. 	Press the settings button and assign the proper channels to axis or set as disabled. 

5. 	Press “Update” then SAVE and restart the DAMS Software. 
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INNCO C03000 Controller
(with CP1500 Arch Scanner and CTE500 Compact turntable)

The INNCO CO3000 controller is a multi-axis controller.  Currently the DAMS supports this controller 
using a CTE5000 compact turntable for azimuth and CP15000 dual-carriage positioner for elevation. 
We recommend this positioner be operated using GPIB.  Before configuring the positioner within the 
DAMS, it must first be added to Agilent VEE Pro Runtime I/O configuration. 

Adding GPIB Device to I/O Configuration

1. 	Click Start → Programs → Agilent VEE Pro Runtime I/O Configuration → I/O Config

2. 	Press “FIND”, it should find the controller

3. 	Right click on the controller and select properties, change the name from “new instrument” to 		
	 INNCOC3000

4. 	Press the “Save” button and then select the blue disk icon to save the configuration. 		

Configuring DAMS software to use the INNCO Controller
		
1. 	Start the DAMS software and press “Positioner Settings”

2. 	Under “Select Controller”, select 3rd Party (see pic below for reference)

3. 	Click the Third Party pull-down and select INNCO C03000

4. 	For “Motor Resolution” enter 1” and a gear ratio of 10 for both azimuth and elevation axes.

5. 	Press the SETTING button located under where you selected the controller and see the settings 		
	 on the following page.
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INNCO C03000 Controller - Axis Configuration

Standard configuration is 3 axes; one turntable and two arc positioners.  Please see the default 
configuration below.  A detailed explanation of the “positioning mode” can be found on the 
next page. 
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INNCO C03000 Controller - Positioning Modes

Monostatic (S11)

	

		
			   Pseudo-Monostatic S21
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INNCO C03000 Controller - Positioning Modes

Bistatic
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Power Saving Options

Be sure to disable screen sleepers, power saving features and other applications, which 
may cause a .DLL or GPIB to crash. 

Other Running Applications

The DAMS Software requires a large amount of CPU and system resources.  We advise 
not having any other applications running while the DAMS Software is in operation.

Reporting Bugs

During especially complex and/or untested scenarios, a software failure may occur.  If 
you encounter such a scenario, please do not hesitate to let us know.  We will happily 
address your problem and may offer you a hot fix to quickly resolve your issue.  
Reporting bugs greatly helps us improve all aspects of our systems.  Please report any 
errors or questions about the software operation to Support@DiamondEng.net.

Tripod Compatibility Information
	
The DAMS system has been designed so that it will operate with nearly any tripod. x000 Series, 
which uses a linear actuator, require a slightly more specific tripod with a pivoting head and a neck 
diameter of about one inch.  When purchasing a new tripod, ensure all parts from the current system 
fit onto the new tripod free of angle or clearance problems.  Once you are ready to configure the 
software please follow the instructions below for calibrating the vertical axis.  If you’re unsure if a 
prospective tripod would be compatible, feel free to contact us and we would be happy to assist.

Matlab Plotting with Windows 7/8 - 64 Bit 
	
When using the DAMS software under 64-bit versions of Windows 7, you must follow the 
instructions below or the software will show a “could not start matlab engine” error code. 

			   1.       Open C:\Program Files\Agilent\Vee Pro Runtime\   (might be Program files(x86))

			   2.       Right click on veerun.exe and select “Properties”

			   3.       Click the compatibility tab and select “Run as Administrator” 

			   4.       Click OK and restart our software.

			   5.       Plot a 3D file, it should plot OK. 

			   6.       If 3D plotting works ok, go back and de-select “Run as administrator”

Special Installation Notes
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Antenna Measurement Studio Software Overview

DAMS Software Basics
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Instrument Selection & Settings

Configuration Versatility

 NOTE:	 For most network analyzers the settings are all made on the analyze 		
			   front panel. 

You can choose from multiple combinations of instruments such as a signal generator 
and a power meter, or a signal generator and a spectrum analyzer. 

VNA Settings (available for certain VNA models)

 NOTE:	 Start frequency, stop frequency and number of points are always set on the analyzer

S-Parameter		  	 This is the primary parameter that will be measured, usually S21 or S22 is 		
					     selected

Alternate Parameter 	 This option will collect an alternate S-Parameter such as S22 		                                             	
                                            (Reflection)  Single Cut - This will only collect alternate parameter data on                    	
                                            the First azimuth cut   	             
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Source Instrument Settings (Generator, or Receive Only)

  NOTE:	 These settings also apply for the RECEIVE ONLY instrument. 

Start / Stop Frequency: 	 Enter the frequency in GHz (decimals are acceptable). 
					     Example: 450Mhz = 0.45

Number of points: 		  Similar to a VNA configuration you may choose the number 			 
					     of frequency points for the sweep, click the “Freq Increments” 			 
					     window to display the calculated Frequency Step.

Output Power:		  Sets the output power of the Signal Generator. Format is dBm.

 

Receive Instrument Settings

Trigger Mode 	 Changes how the power meter reads the sensor.  This setting is only applied to 		
				    certain meters. 

Trigger Delay		 Sets the delay / settling time between when the signal generator is called 		
				    and the power meter is queried for a reading. Format is in seconds. 
				    (Example: 1/10 second = 0.10)

Sweep Delay		  This sets the number of seconds the signal generator will wait before initiating 		
				    the sweep. This allows larger antennas a chance to completely stop moving. 
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Receive Instrument (Spectrum Analyzer Settings)

Sweep Settings

			   Span			   Span of spectrum analyzer sweep.  Format is in Hz.

			   Res Bandwidth	 Sets bandwidth window on spectrum analyzer 		
						      (the smaller the window, the faster the sweep). 		
						      Format is in GHz. 

			   Video Bandwidth	 Sets video bandwidth window on spectrum 		
						      analyzer.

Video Averaging		

			   Average Count	 Sets number of times spectrum analyzer will 		
						      average the Video BW before the data is read.

Max Hold Settings

			   Max Hold On/Off	 Turns the Max Hold option on or off.

			   Measure Delay	 Sets how long the spectrum analyzer sweeps and 	
						      updates the max hold before sending data to the 	
						      software. This function is useful for non-CW signals.

Display Settings		

			   Reference Level 	 Sets the reference level of the spectrum analyzer 	
						      display.  (Settings in DB)

			   dB/Div		  Sets the “dB per division” scale on spectrum 		
						      analyzer display.

Triggering Options

			   Sequence Delay	 Sets the delay time between when the platform 		
						      starts and the  measurement sequence is  started

			   RX Delay		  Sets the delay time between the time the signal 
						      generator is called and the spectrum analyzer is 
						      triggered to sweep. 
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VNA Emulator / Antenna Library

Antenna Simulation Library

This feature is accessed by selecting “VNA Emulator” from the instrument 
pull-down. Select the type of antenna you would like to generate and enter 
the desired start, stop frequencies and number of frequency points. Patterns 
will be generated by using the “measure” buttons on the front panel of the 
software, it is advisable to disable motor movement to reduce time.

Ideal 1/4 wave Dipole  - Generates an ideal dipole pattern for every frequency 

Dipole Arbitrary Length / Radius - Generates frequency accurate dipole patterns 
based on the entered dimensions.

Patch Antenna - Enter the size of the patch and air-gap to generate pattern, pattern 
can also be peaked to any desired AZ/EL position

Axial Helix - Generates pattern based off entered helix properties

Arbitrary Beam- Generates an ideal beam at a desired angle, Gain is dependent on 
beamwidth

Ideal Parabolic Dish - Enter dish diameter and desired peak AZ/EL position for frequency accurate 
pattern.
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Azimuth extents setup

Degrees Per Measurement	 Displays current degrees per measurement based off of the 		
						      current extent settings for this axis.

Show Hig Res Values     	              Calcualtes high resolution step values (having this enabled will 		
		                                                   Cause high refresh times to display resolutions)   

Azimuth Start Value			  Selects starting position of measurement.

Azimuth Stop Value			  Selects stop position of measurement.

Degrees Per Measurement	 Contains all possible degrees per measurement setting       		
	  					     combinations for selected total rotation and selected positioner.

Beam Cut / Full Cut			   Enables measuring from a negative angle to a positive angle, 		
						      versus 0-360 for the full cut option.
 
Run as Z Axis			               When selected, instead of moving the rotary stage, it will step the		
					                  z axis , when running in this mode , degrees is equivalent to mm

Lock Sliders				    Locks the two sliders in beam scan mode offering mirrored 		
						      extents from 0 degrees.

Movement Settings & Position Extents
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Elevation Setup

Degrees Per Measurement	 Displays current degrees per measurement based off of the 		
						      current extent settings for this axis.

Show Hig Res Values     	              Calcualtes high resolution step values (having this enabled will 		
		                                                   Cause high refresh times to display resolutions)   

Azimuth Start Value			  Selects starting position of measurement.

Azimuth Stop Value			  Selects stop position of measurement.

Degrees Per Measurement	 Contains all possible degrees per measurement setting       		
	  					     combinations for selected total rotation and selected positioner.

Beam Cut / Full Cut			   Enables measuring from a negative angle to a positive angle, 		
						      versus 0-360 for the full cut option.
 
Run as Z Axis			               When selected, instead of moving the rotary stage, it will step the		
					                  z axis , when running in this mode , degrees is equivalent to mm

Lock Sliders				    Locks the two sliders in beam scan mode offering mirrored 		
						      extents from 0 degrees.

Jog Settings and Control

Jog Delta			   Moves the selected axis relative to current position, move is completed 		
	  				    immediately after selection 	  
Jog To 	 		  Moves selected axis to absolute position, move is completed immediately 	
					     after selection 	
Move to Direct Position   Moves to the specified AZ/EL Position

Zero Positioner          	 Sets current position as 0,0
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Position Tracking

A position tracking function is provided to reduce the chances of having to re-zero the 
positioner upon software restart or positioner power loss.  This feature is used for any 
of our positioners without absolute feedback (such as a resolver or encoder) and can 
be enabled under positioner settings.  This function works by writing to a file each time 
the positioner is moved - both the position and an internal count from the positioner is 
written.  When the software is restarted, it will compare the stored count to the current 
controller count to validate the stored position. 

This screen shown at software startup, GREEN windows indicate matching count 
values.  Displayed position is accurate unless it has been physically forced off of stored 
position.  RED windows indicate that there is a count discrepancy.  If the positioner has 
been power cycled but NOT moved it is generally safe to update to stored position.   

Stored Count			  Last controller count stored to a file	  

Current Count 	 	 Current count read from controller					   

Stored Position		  The last store position for that axis

Update ALL           	          Sets current position as stored position for all axes

Update 			   Updates individual axis position to stored value	  

Do not update	 	 Ignores saved positions and starts software with 0 values for all axes		
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Platform Settings and Calibration 

These settings allow you to tailor the software for your specific configuration needs. 
You can specify the speed, controller type gear ratio, controller driver, acceleration, 
deceleration and hold settings on the newer Platform Controllers. When choosing “Low 
Gear” option, the default motor speed will automatically change to the default value.

Settings For All Models

Select Controller - Choose between USB and and x100 series controller models. See 
“Controller Setup & USB Driver Installation” for help identifying your controller. 

Move/Measure on/off - Allows you to turn the motors off while running the software 
as if 	the motors were connected to the system.

Full Spherical Mount - Check this box if you are using FSM Series mounts.

Settings Applicable to x000 Series
Motor Resolution - Specifies resolution of stepper motor installed on platform.  This 
number is .1125 for microstepping controllers and 1.8 for legacy controllers
Gear Ratio - The entire gear ratio between the motor and the rotating  platform 
hub. For DAMS x000 Belt series positioners this value is usually 14.4 unless instructed 
otherwise
FSM Conical Elevation
When using the FSM mount you have the option to measure a -180 to 180 degree elevation cut 
instead of the standard -90 to +90 cut do NOT use with Scan Az/El

Positioner Settings
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Motor Hold Option
We recommend using the motor hold option on the  HORIZONTAL axis to ensure the platform does 
not move on it’s own between movement sequences. Vertical hold should only be enabled when 
using a heavy load which causes the lead screw to move on it’s own. 

Move Buttons
After changing the acceleration setting, these buttons allow for testing. 

Start Speed
Sets the number of steps per second the motor will start/stop 					   
moving at. 

End Speed
Maximum number of steps per second motor will move. 

Slope
Sets the acceleration/deceleration ramp by setting time between motor start speed and maximum 
end speed. 0 will disable acceleration while 1 will offer the slowest acceleration and deceleration.

Settings Applicable to x100 and x250 Series

x100 Model
Choose your model if using a x100 or x250 series heavy duty positioner.

x100 Pan Correction
Special 6100 pan correction.  Use only if instructed to do so.

x100 FSM Port
If using a x100 series +FSM positioner, select port for controller.

x100 Speed Settings
Applies to x100 models only, use the GET button to read the current speed setting and the SET 
buttons to send the settings to the positioner.

Motor Resolution
For x100 and x250 series, this value should be 1 (if using FSM mount this number should be 1.8 for 
the azimuth axis.

Gear Ratio
For 6100,7100, and X250 systems this number is 10 for 5100 models this number is 25, if using FSM 
Mount the value should be 14.4

Vert Disable
This option will disable the vertical movement on the positioner for all move and reset commands. 
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x000 Series Vertical/Tilt Settings

  NOTE:	 Applies to x000 series actuator based vertical/elevation movement only.

These settings will configure the tilt/elevation axis calibration. The design of the 
vertical  axis requires a number of calibration contents that are sometimes specific to 
a particular unit. Your unit will have a sticker that has all of the parameters either on 
the control box or the platform itself. If your sticker only has 2 numbers ex. 2083/3.99, 
these are the values in the GREEN section of the calibration menu and you do NOT 
need to change any of the numbers in the RED section. Simply enter your numbers in 
the windows and press save then use the “QUIT” button in the software and restart the 
software to activate the changes. 

Vertical Calibration Settings
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Selecting and configuring a polarization device

For instructions on using the polarization feature see “Polarization Switching” under “making 
measurements” 

The DAMS software is capable of switching measurement polarization using Manual, Electronic, or 
rotary switching methods.  Polarization Settings can be accessed from the settings button located 
under the polarization heading on the front page of the software. 

Configuring a Mini-Circuits USB Switch

1.	 	 Install the Mini-Circuits software onto the PC before configuring the DAMS software to use the 
switch. 

2.	 	 Inside of the polarization settings, choose the Mini-Circuits selection from the pull-down menu 
and press settings to open the dialog box below. 

3.	 	 Enter the serial number of your switch (found on the back or bottom of the unit) and press 
“Update and Connect”.  The status should now say connected and you should be able to 
manually change the switch position.   Press OK to save your settings.

 

Polarization Configuration
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Configuring a rotary polarization stage

As of the writing of this manual, systems equipped with a 3-axes controller can use the Z-axis 
channel to control a rotary positioner stage.  Technically, any stepper motor controlled stage 
can be used if the gear ratio and motor resolution is known.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Enter the above values just as you would in positioner settings screen.  For more information, 
please view the “Positioner Settings” section.
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Using the Z-Axis

(Applies to D6050 and all other models with Z-Axis option) 

Before you use the Z-axis option, you ensure it has been enabled.  This will show as an option for “Z Axis 
Control”  located above the measure buttons.  To enable this option, open positioner settings and select 
Z-Axis checkbox on the upper section of the page (see red box highlights below).

To access the Z-axis motor control screen, select the Z Axis Control button on the main screen (see yellow 
box highlight above).  This will open the following control options.

Z Axis Motor Control

Move to 0 (Home) 	 Moves the axis to the last position set as 0 

Delta Move + 	 Moves entered distance from current away from turntable center

Delta Move - 		 Move entered distance from current position towards turntable center

Soft Limits 			  Values are in mm.  To find your soft limits, zero the positioner along the Z-axis, 	
			   then measure from each side of the ball nut to the limit switch.  Click “SET” and 	
			   input these values.

Current Position 	 Displays the current position 

Set Zero  			   Offers options for zeroing the axis (see next page)

Steps Traveled	 Shows the real number of steps the axis was commanded to move 

Distance Traveled	 Shows the distance the z-axis moved during last move
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Z Axis Motor Control

Set Zero	 Sets software position to zero 

Set Zero, record offset	 Sets current position to 0, records step offset value (if available to use to re-zero the 		
	 positioner

Search, Move to zero	 Moves the axis unitil the home limit is struck, from here the positioner can be moved back 
to 		  a stored zero position. 
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Z-Axis Homing and Limit Switches

Applies to mmW models and other models with Z-Axis that feature home and or limit switches 

The limit switches serve two purposes, to prevent over-travel of the axis and to provide a known reference 
position for purposes of zeroing.  Once the known position has been reached the internal controller count 
can be the monitored.  The axis does not contain an encoder, so if the power to the controller is reset, the 
software is restarted, or the axis is manually moved, the software cannot track it’s position.  In these cases 
it’s necessary to either use a stored offset or create a new offset.  The default stored offset is roughly at the 
center of the ball screw.

Manual Jogging and Soft Limits

1. Press “Zero Positioner” 

2. Select “Search / move to zero” 

The positioner will move up to 370 degrees 
clockwise to find the limit swtich.When the 
switch has been found, use the “Stored 
position” option to have the software move 
the turntable to the physical 0 location.

Creating a new zero offset

An offset can ONLY be stored once either the Home or Max limit switch has been struck once 
during the software sesssion.

1. 	Open Z Axis Control and press “Set Zero”  

2. 	 If the home limit switch has not been struck press “search for home”.  The positioner will 		
	 move to home.

3. 	Select “move to standard offset” this will move the Z axis to the general center or zero 		
	 postion of the axis.

4. 	Using the Move +/- buttons or the “Move to” button, find the position you want to set as zero.

5. 	Open the “zet zero” option and press Set Zero/Record offset, this will record the proper 		
	 motor step count from the home switch location. 

6. 	The software Z position is now set to zero and all movements will be realitive. 

Using a stored offset

1. 	Open Z Axis Control and press “Set Zero”  

2. 	Select “Search / Move to zero” 

3. 	The positioner will move to the home switch and stop.  When prompted, select “move to 		
	 stored offset” which will move the Z axis to the position last stored using the Z axis zeroing 	
	 function.  The software position is reset to zero and all movements are relative.
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Measurement Calibration Settings

Scalar Calibration - For cabling and / or substitution

This feature enables you to make a scalar cable or substitution calibration of your system by 
normalizing any system gains or losses to 0dB.  If a calibrated reference antenna with data is 
connected in place of DUT, the entire link (including path loss) can be normalized to the calibrated 
antenna values. 

An in depth explanation and example is located in “System Calibration”.

  NOTE:	 If using a power meter with non-programmed sensor, you MUST load or enter a 		
			   power sensor calibration table before performing a scalar calibration.

 
 
 

Load Cal		  Load a calibration file from your computer

Save Cal		  Save a calibration file on your computer

Begin Calibration	 Triggers a single cable / link measurement from analyzer / equipment

Apply Reference	 Substitution-style calibration with calibrated reference in place of DUT 			
				    performed after measuring link

Averaging		  In cases of large amounts of background noise you may want to average the 		
				    calibration measurements

Interpolation		 If measurement settings are within the frequency range of the calibration but  	      	
                                   the number of points vary the software will linear interpolate the calibration.

Pad (-dB)		  If using a post amp with attenuator, enter the attenuator value in this window.

Power Head Cal	 This button invokes the power sensor calibration menu. 
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Power Sensor Calibration

The Power Head / Sensor calibration menu is located in the Scalar Calibration section.

Enter PM Cal Factors	 Allows entry of calibration table directly to check 		
					     compatibly.

Compile Array		  Compile the manually entered Cal-Factors and display on 	
					     chart.

Load Cal			   Load a calibration file from your computer. 

Load from Notepad File	 Load a file containing a Cal-Factor lookup table.

Sample Notepad File	 Shows how a Cal-Factor Notepad file needs to look

Test				   Enter a frequency within the value of the Cal-Factor table, 	
					     you will see the corresponding exact Cal-Factor in the 		
					     “Calculated CF” window. 
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Control Overview

Measure Azimuth Cut	 Software will begin making measurements by moving the azimuth 		
				              axis, and retrieving the data from the instrument.  Button 		                                               	
                                             remains  grayed out while measurement is in progress.

Measure Elevation Cut	 Software will begin making measurements by moving the platform 		
					     horizontally, and retrieving the data from the network analyzer. 			 
					     Button will remain grayed out while measurement is in progress.

Scan AzEl			   Software will begin what is called an “Az/El Scan” by making a complete 		
					     Azimuth cut and then move to the next elevation position to 			 
				              make another complete horizontal sweep.  This process will continue 		
					     until the platform reaches the ending elevation position.

Reset All-Init Pos		  This button must be pressed before making another measurement if you 		
					     have already made one.  Button will clear all plots on the front page and 		
					     reset everything to 0. 

Pause Measurement		 Will pause and interrupt the measurement process after the positioner 		
					     has moved, before the signal is measured. 

Stop Measurement		  Stops the measurement at the next point in the measurement cycle.  		
					     After the measurement has stopped, you may reset the positioner/plots 		
					     and start over or change settings.

S21 Averaging		  Turning this feature on will perform averaging on a 	
					     specified number of  VNA Sweeps for each physical 	
					     measurement position. The All-Min/Max option 		
					     discards max and min sweeps and average the rest.

	
Proceed to Data Processing

After making measurements, this button allows you to view or 
manipulate any aspect of the measurement, as well as allowing 
you to view data in different formats such as Polar, Mag or 3D.

Measurement Controls
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Measurement Status Window

The measurement status window displays all of the current measurement parameters 
and will update automatically during the measurement process.  

Graphical Status Display

The graphical status windows allows you to view the real-time center frequency data as 
it’s captured.  All status graphs display the center measurement frequency - especially 
useful for observing the measurement for proper pattern and levels.

CW Monitor Plot	                                    	Amplitude in dB of the measured data

Antenna Polar Radiation Pattern		  Real-time linear polar pattern of measured 	
							       antenna at selected frequency

AZ Progress					     Shows progress of selected azimuth extents

EL  Progress					     Shows progress of selected elevation extents

S21 Averaging (f)				    Turns frequency averaging on/off

# Averages				                 Sets number of sweep averages

All - min/max				    Averages without min/max values

Meas Delay				                 Delay in seconds before measuring        

Measurement Status & Displays
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Monitor Plot Options

The monitor plot option can be used to select the frequency of the data displayed on 
the main measurement page.  This will normally default to the first frequency or center 
frequency of the measurement.

In addition, the monitor plot options can be used to view real-time link or gain data.

Select Frequency	          Selects the frequency which will be displayed on the  		
                                            measurement page plots

Display Link Data		  Continuously queries the over-frequency link data from the 	
                                            VNA and displays it on the plot

Realtime Gain Frequency	Provides the option to load path and reference data to show  	
                                            the actual gain over frequency of your AUT in real time

Exit				    Applies the selected and exits 
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Data Processing Introduction

Introduction

Our data processing features are your gateway to unlocking all the data contained within your 
antenna measurements.  After making your initial measurement of the antenna, press the “Data 
Processing” button (located in the “Post Measurement Options” window of the main software) and 
you will be taken to the screen shown below. 

About Data Registers

When working with data in the Data Processing feature all of the data is stored in registers.  These 
registers allow you to have “holding space” for data sets. This is a very useful way to work with 
multiple measurements from other antennas or variations of the current antenna. There are five (5) 
registers total: four (4) storage registers and one (1) active register. 
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Active Register
 
After completing a measurement and opening the Data Processing feature, the entire 
data set from your measurement will automatically be placed into the “Active” Data 
Register.  The Active Register is applied to all functions including 3D plots and Data 
Export functions, (with the exception of the Measurement Calculator, which can pull 
data from any of the 5 registers).  We suggest storing your data to a Register and then 
saving it to disk so a permanent copy of the raw data is saved.

Storage Registers 1-4

The Data Storage Registers offer space to put up to four different measurement sets 
that you can recall at any point in time, or permanently save the set registers to disc. 

Data Storage Button	 All data in Active Register is stored to the storage button 	
					     you chose

Recall Button			  All data in chosen storage register will be written to active 	
					     register for viewing or modification

Load Reg 1-4 From Disc	 Load a set of 4 registers from the disc

Save Reg 1-4 To Disc	 Save a set of 4 registers to the disc

Clear All Registers		  Clear all data from registers 1-4
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Register Utilities
 
The register utility pull-down contains a number of tools for working with registry data. 
These tools will help you perform data functions including export, import, and merge.

	

Load Single Register	 Loads a single register from a different saved data set into 	
					     any of the current registers 1-4

Frequency Merge		  Used for merging the upper and lower frequency bands 	  
					     from two identical sets. Requires duplicate start/stop 		
					     frequencies, number of points, and az/el points

Apply CAL file		  If a measurement was made without having the scalar 		
					     calibration applied it can be applied post-measurement

.TXT Export			   Exports the entire/selected contents of any register 1-4, this 	
					     data can be imported directly to excel and other programs

Excel Reg. Export		  Exports any register directly to excel in either data only or 	
					     as a simple report

Import			   Imports external data directly to a register, external data 		
					     must be in a specific format

Clear All Registers		  Clears registers 1-4 with option for active register (Reg0)

Recovery			   Load the last completed raw measurement

Reverse Azimuth		  Reverses the azimuth cut for every elevation angle

Select Frequency Points	 Generates a new data set with a selected group of  
					     frequencies or reducing the entire frequency set to a 		
					     specific number of points
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Register Utilities (continued)
 

Data Editor			   This will enable data truncation and number of frequency 	
					     points reduction. Simple enter the Min/Max extents and the 	
					     results will load into REG0

MSI/Planet Export		  This module will export a file compatible with MSI / Planet 
					     site planing software, requires a single AZ/EL cut with 1 		
					     degree resolution 

Stitching Tool		  Cuts that start at 0 and end at 360 degrees may have 
					     different amplitude values due to noise, this feature will 		
					     stich the en-points into the same amplitude to eliminate 		
					     the gap found in 3D or 2D polar plots.

Boresight Normalization	 This module will normalize the boresight gain levels to
					     those imported from a previously generated calibration file.  	
					     Results are stored back to the Active register (REG0)

Total Power Addition	 Performs a total power addition of Register 1 and 2, the 
					     results will be stored to REG 3

Large File Gain Transfer	 Performs gain transfer on measurement sets greater than 	
					     500K data points.

Process Circular		  Will take gain data in REG1 and REG 2 and process as 		
					     circular, RHCP and LHCP data will be stored to REG3 and 		
					     REG 4 Respectively 

N2F Export			   Exports H-POL and V-POL data for us in Howland Co’s N2F 	
					     nearfield to farfield data processing software. 

N2F Peak Gain Generator	Exports H-POL and V-POL data for us in Howland Co’s N2F 
					     nearfield to farfield data processing software. 
					     (NOTE: This feature still in development.)
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Data Manipulation Options

After you have made a measurement, use these options to correct for things like 
reference gain, path loss, or to plot efficiency. 

Generate Path Loss		  Calculates the path loss over the measured frequency range 	
					     and specified distance

Import Ref. Antenna	 Applies gain correction for a calibrated reference antenna 	
					     and values are loaded from text file

Gain Xfer			   Calculates AUT gain by removing path loss and reference 	
					     gain (See “Gain Transfer Function” for more information)

Efficiency			   Generates the efficiency over frequency for the measured 	
					     AUT 

3 Point Gain			   Activates the 3-point method for calculating gain 

Phase Center  		  Calculates phase center when used with appropriate data. 

Flip EL Sign			   Reverses the elevation indexes, effectively reversing the 		
					     elevation plots
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Visualization Options

The data visualization options enables you to view the Antenna Data in a wide variety 
of formats.

Azimuth vs. Frequency vs. Amplitude 3D-Plot

This plot is the most versatile of the 3D-plots and gives a good idea of the frequency 
response versus rotation of the antenna you have measured.  If you have made AZ/EL 
measurements you can use the AZ/EL 3D-plot for a more detailed view. 

Features:	 View entire data set at once
			   Full Plot Rotation 
			   Zoom In/Out feature
			   Line and Notation Tools 
			   Exportable to common graphic formats
			   Printable

Az/El vs. Amplitude 3D-Plot

After you make a AZ/EL measurement, you can view the azimuth versus the elevation for any 
measured frequency by using the AZ/EL 3D-Plot.  Use the azimuth versus frequency 3D-plot to view 
frequency response to aid in the selection of the single frequency. 

Features:	 View AZ/EE data for any frequency point
			   Full plot rotation 
			   Zoom in/out features
			   Line and notation tools 
			   Exportable to common graphic formats
			   Printable
	  
	  

Data Visualization
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Spherical 3D Plots

When an Az/El scan measurement is made, you can plot the data in true 3D (up to the 
extents of your measurement.).  This data can be viewed in true 3D, mapped onto a 
sphere, and even compared to an ideal isosphere or dipole right on the same plot.

 IMPORTANT:  Spherical plots will only work if AZ/EL measurement data is loaded 	
				    in Active Register.

Frequency - Select which frequency to plot

Generate Plot - Click after configuration is set

Data Plotting Options - Modify how measured data is displayed in plot window 
(select 20log for dBi)

Iso-Sphere - Generates true iso-sphere on same plot as measured data.  Enter the 
desired IsoSphere size in dBi.  NOTE: Max value is updated AFTER plotting the selected 
frequency

Dipole Generator - Generates spherical dipole plot on same plot as measured data. 
Change the size of the dipole using the Multiplier 1 = Ideal dipole gain.

Viewpoint - Sets default viewpoint for 3D plots

Multiple Plots - Enables plotting of multiple frequencies
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Spherical Plot Examples

Map to Sphere

Map to Sphere over Frequency

Map to Sphere (with grid)

Standard Spherical Spherical over Iso-Sphere Parabolic Dish
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Dynamic Polar Plot 

Dynamic Polar Plot offers a linear or log polar 2D look into the rotation gain pattern of a 
measured antenna for a specified frequency, and Az, or El point.

		  Features: 		  Linear or Log Format
					     Multiple Scale Options
					     Automatically updates 
					     Keep Max Function 
					     Data Export 
					     Auto Scale Function
					     4 Trace Plotting
					     Dual Markers
					     Marker Delta Readout 
					     Azimuth or Elevation Plots
					     Printable
					     Find Max Signal
					     GnuPlot Plots
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Amplitude Plot

The Dynamic Amplitude Plot is accessible through the Polar Plot window.

This plot is a sub-function of the polar plot. This function allows you to view the 
amplitude while adjusting the sliders in the polar plot window. The plot is closed by 
pressing the “Amplitude Plot” button again.

Over Frequency Plot

This plot is also accessed through the Polar Plot window. It displays the over frequency 
data for the selected Az/El position set via the polar plot sliders. The plot is closed by 
pressing the “Over Freq Plot” button again 
For multiple trace plots see the section titled “Multiple Trace Plots”
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GnuPlot Plots

This plotting feature produces publish quality plots based on certain plots within the 
DAMS Software, Presently the GnuPlot feature is available for the following plots, the 
Plot is generated by pressing the “Plot with GnuPlot” button located within the plot.



87 Software Overview

Group Delay Function

Allows the analysis of the Group Delay and Path Propagation data. You can also make 
an accurate measurement of the antenna distances using this feature.

    
Features: 

Distance Scale Functions
Data Export 
Auto Scale Function
Printable Plots
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Overview

Use this option to perform arithmetic operations on the measurement registers. For 
example if you make measurements on one antenna and wish to compare the results 
to another antenna at each point of rotation and each frequency. Or if you have a 
calibrated reference antenna an wish to normalize additional measurements to the max 
or min value of the reference antenna. Remember all measurement data is linear so 
you may want to “LOG” the data before doing math. If you select MAX or MIN then all 
measurement elements will be replaced with MAX or MIN. This creates a normalization 
reference if you do your math correctly.

Measurement Calculator
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Making Measurements

Basic and Advanced Measurements
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Scalar System Calibration
 

  NOTE: If you have already calibrated any system losses (cables, etc) using VNA calibration 
you do not need to perform a scalar cable calibration, a full 2 port calibration of the VNA is 
recommended when making phase dependent measurements

Scalar Calibration with Generator and Receiver Configuration
 

1.	 Select your Source Instrument and click the “Settings” button, which is located 		
	 below the icon to configure parameters for your measurement (start, stop, number 	
	 of points, etc.). 
2.  	Select receiver from pull-down and configure any applicable settings.   
3.	 Connect system as shown in the selected diagram.
4.	 Press the Begin Calibration button, a trace will be displayed when complete
5.	 If performing substitution calibration press the “apply reference” button and import 	
	 the calibrated reference data
6.  Save calibration and exit to apply to measurement.

Performing Scalar Calibration with VNA configuration 
 
1.	 Configure your VNA for desired start/stop frequency and number of points. 
2. 	Connect system as shown in the diagram.
3.	 Press the Begin Calibration button and a trace will be displayed when complete.
4.	 If performing substitution calibration press the “apply reference” button and import 	
	 the calibrated reference data.
5.  Save calibration.  When exiting you will be prompted to apply the calibration to the   	
     measurement.

  NOTE:	 If using an amplifier, be sure to attenuate its signal to avoid exceeding 	
			   maximum input power on your VNA.

SCALAR CALIBRATION
Positioner / AUT

(Second VNA port / Tx/Rx)

Source Reciever

VNA / ENA / PNA

-Spec Analyzer
-Power Meter
-Voltmeter

-Sig Gen
-Self Generating
-Emulator

Tx/Rx

Reference Antenna
(First VNA port / Tx/Rx)

Connect Reference Antenna Cable to top of Positioner

POWER AMPLIFIER
(Requires Attenuator)
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Scalar System Calibration - Substitution 
 

  NOTE: 	 When a Substitution calibration is made there is NO post processing necessary. All of 		
			   your data will be collected in dBi. 

Performing Substitution Calibration with calibrated reference 
antenna

1.	 Place a calibrated antenna with known values in place of the DUT.

2.   Perform both sides of the Scalar Calibration routine as described above.

3.   Press the Apply Horn button to apply the reference antenna data to measured data.

4.   Save and apply your calibration data.

5.   Replace the Calibrated antenna with your DUT.

6.   Make your measurement, all measured data will now be in dBi.
			 

SUBSTITUTION CAL

Positioner / AUT
(Second VNA port / Tx/Rx)

Source Reciever

VNA / ENA / PNA

-Spec Analyzer
-Power Meter
-Voltmeter

-Sig Gen
-Self Generating
-Emulator

Tx/Rx

TX Antenna
(First VNA port / Tx/Rx)

1. Attach calibrated reference to positoner
2. Press “Begin Cal” to measure link
3. Press “Apply horn” to load reference data.
4. Replace reference with AUT

POWER AMPLIFIER
(optional))

Calibrated Reference
w/data
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Calibration Profiles

Introduction 

Calibration profiles store specific details such as scalar/substitution calibration files, reference 
antenna data, and path loss information, this data will be automatically applied to measurements 
eliminating the need for any post processing. Multiple files can be created for different 
measurement setups. 

Scalar / Substitution Calibration
Apply data has been saved using the “scalar calibration” module within the software. 
A cable calibration is generally used in conjunction with Automatic gain transfer 
whereas a substitution calibration is not used with gain transfer, the resultant data is 
stored in the specified destination register

Automatic Gain Transfer
Path and reference antenna data is automatically applied to the measurement when it 
is complete, no further processing is necessary, measurement results will be in dBi.

Destination Register
Specify the destination register and description for resultant data.
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Auto / Manual Polarization Switching

  NOTE:	 Software must be configured for a supported type of polarizer or 		
			   “manual” which will prompt to manually change polarization 

Overview

This feature allows fully automated collection of both H + V Polarization of the DUT 
including automatic gain calculation. Polarization switching can be performed at every 
physical point or at every complete measurement.  Scalar / Substitution, and/or gain 
transfer calibration can automatically be applied during collection 

Polarizer Type	 Selects the type of polarizer that will be used, selecting manual 	
				    will cause a software prompt to manually change polarization, 		
				    the settings button changes polarizer specific settings 			
		           		       					   
Enable / Disable	 When enabled, the software will perform dual polarization 		
				    measurements for Azimuth, Elevation, or 3D scans as configured 	
				    on this page

Switching Mode	 Per-Point will switch the polarization at every physical point 
				    the positioner stops, for electronic switching this option 
				    will reduce error by only requiring the AUT to move only once 		
				    to each position. Per measurement will complete one full 		
				    measurement at each polarization. It is recommended to perform 	
				    a per measurement sweep for any rotary positioner to reduce 		
				    measurement time and wear on the polarization stage.
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Scalar / Substitution cal 	 This option will reference to any calibration file made using the DAMS 		
				         	 scalar / system calibration function located on the front page, the 		
					     calibration can be just cable calibration or a normalized substitution		
					     calibration.
				             		      					   
Auto Gain Transfer 	 	 This option will apply the selected reference antenna file and path 		
				             distance correction to the measured data, a separate gain file can  		
				     	 be used for each polarization if using a dual polarization reference or 
					     multiple antennas.  The cable loss must still be corrected. This can be 		
					     used in conjunction with a scalar calibration file to correct for cable loss.

Destination Register	 When a dual polarization measurement has been completed, the data 		
					     needs to be stored into one of the 4 data registers. These options will set 		
					     both the target register and description. 

Azimuth & Elevation Measurements

  NOTE:	 Software assumes positioner is level when started or after being reset. If it is NOT, use 		
		                 “Vertical Jog” to move platform to true level and “set to zero” before making 	   		
                        measurements.

Basic Azimuth or Elevation Measurement 
 
1.	 Ensure power cables are connected, software is running and positioner movement is confirmed.

2.	 Attach AUT to rotator platform or FSM (If equipped) with SMA connector.

3.	 Ensure controller power is ON.

4.	 Select S21 on your analyzer, AND linear polar OR smith chart.  If you have a saved calibration file, 		
	 be sure to load it before making measurements.  Example: 4 to 6 GHz @ 201 Points.

  NOTE:	 If your analyzer has not been calibrated, follow the appropriate calibration procedure.

5.	 Click “Configure Extents” to configure the start/stop position and resolution of this measurement.

7.	 Click “Measure Azimuth Cut” or “Measure Elevation Cut” to start measurement process.

8.	 During measurement process, the rotator platform will begin moving and center frequency 		
	 data should begin appearing on screen.  “Measure Azimuth Cut” will remain greyed out during 		
	 measurements.  Once measurement completes, button will reappear. Then you may enter 		
	 the “Data Processing” section or perform other post-measurement options. 
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Gain Transfer Function

Overview

The gain transfer function will use 
previously generated path loss 
and reference data to calculate the 
dBi gain of the measured antenna 
across all angles and frequencies. 
Corrected data will be stored 
into Reg4 and the Active Register 
(Reg0). 

After calculating, save Reg1-4 to 
the hard drive this file will contain 
original and calculated data 
including path and REF data. 

2. Path loss and REF buttons must be 
green indicating data is present, click 
to set path or reference data

1. Measurement data must
be present in Reg 1

3. Run Gain Transfer function

Resultant
AUT Gain Data
(Also in Reg0)

Data processing page after Gain Transfer has been completed

Gain Transfer Module
To Perform Gain Transfer

Prerequisite:   Measurement with VNA or DAMS Scalar Calibration Enabled
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Antenna Gain Pattern 

Once the gain transfer has been completed the antenna pattern can be plotted in a number of 
ways.  The quickest way to analyze the max gain positions and frequencies is with the polar plot. Up 
to four antenna traces can be plotted at one time. The radiation pattern for any frequency or axis 
can be displayed simply by moving the sliders to the desired setting.

Locating maximum gain frequency / angle:
	
		  1. Select 20Log to view the gain in dB.
		  2. Press “Go to Max signal” and plot will be changed to plot with the maximum gain. 
		  3. Max gain value for specified frequency/cut will be displayed left of polar plot.

(Max Gain for displayed pattern / freq.)2. Go to Max1. Display 20Log

Antenna azimuth pattern showing a peak gain of 8.86 dBi at 15 degrees elevation
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Basic AZ/EL Scan Measurement
 
1.	 Ensure rotator power is securely attached and plugged in.

2.	 Attach Antenna to rotator platform using a SMA connector.

  NOTE:	 For directional antennas, we recommend starting the max gain point of 	
			   the antenna 180 degrees from the source antenna.

3.	 Turn platform power ON.

4.	 On your analyzer select S21, POLAR Plot and the proper instrument state.
	 Example: 4 to 6 GHz @ 201 Points.

5.	 Click “Configure Extents” to select the Start/Stop positions, resolution, etc.

6. 	Press the “Scan AZ/EL” button to begin measurement process. 

7.	 During the process, the rotator platform will make a complete azimuth cut, 		
	 then move to the next desired elevation point, and then it will repeat the azimuth 	
	 cut.  You should also see some data starting to appear on your screen at this 		
	 time.  The “Scan AZ/EL” button will remain  greyed out during the measurement 		
	 process.  Only after the button returns to it’s normal state is your measuring process 	
	 is complete and when you may continue on to Data Processing.

Example Result

Performing Azimuth/Elevation Scan Measurement
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Circular Measurement Procedure
 
1.	 	Measure AUT with Horn in vertical position and save that 

data to REG1. 

2.	 	Rotate Reference Horn 90 degrees counter clock-wise 
(from behind reference).  Repeat measurement and save 
data to REG2. 

3.	 	Now invoke the “Path Loss Calculator” and specify 
the appropriate figures.  Once completed, ensure 
the “Generate Path Loss” button is green as shown 
below.  The green signifies that the data has been saved 
internally. 

4.	 	Once completed, invoke the “Import REF Antenna” button to load the appropriate calibration 
data.  Again, verify this button has also now turned green as shown below: 

5.	 	 Invoke Gain Xfer and specify Circular Gain 

6.	 	Use KEEP, Normalize and don’t plot to compare LHC RHC.  Scale to 20Log and set contour and 
position markers to measure LHC and RHC difference.

  NOTE:	 Incorrect rotation of the reference horn will switch LHC and RHC. The DAMs is set up 		
			   for CCW rotation. Vertical orientation is arbitrary.  The difference between the 	H and		
			   V measurement must be 90 degrees.

Example Result

Measuring a Left Hand Circular Double Helix
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Performing 3-Antenna Calibration

Summary 

Three unknown antennas can be measured against each other to obtain the realized dBi gain for 
each antenna, this data can then be viewed, saved, or exported into files. If you wish to use this data 
for a measurement, you must export the data and make a reference antenna file with the data in dBi.

Prerequisites
 
1.	 	Calibrate all cabling using either a VNA calibration or DAMS Scalar Calibration

Procedure
 
1.	 	 Label your antennas A, B, and C. for easy identification. 
2.	 	Click “Automated Functions” on the front page and select “3 Point Collection” this will launch the 

Automated 3 Point module.
3.	 	Press the start button and follow the on-screen instructions

4.	 	When all 3 steps have been completed, proceed to the data processing section and launch the 3 
point gain module.  

		

											           Continues next page...
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3-Point Gain Module

Launching the 3-Point Gain module 

The 3 point gain module is located in the data processing section.  It will take the 3 measurements 
you’ve already made in the previous steps and convert them all to gain measurements for each 
individual AUT (A, B, and C)

Prerequisites

	 You must first use either the automated 3-point collection or manually measure 3 	
		  required pairs and store them to the appropriate registers.

REGS BEFORE

REGS AFTER 

Viewing Data

Recall your desired register and open the Polar Plot → Over Frequency Plot to view the calibrated 
data for each antenna, use .TXT or Excel Export options to export the data. 
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Multi-Positioner Automation Module

This module, located under Automated Functions on he main page will set an auxillary positioner 
to a specific position from a list or dynamically updated file and perform a full scan using the 
primary posisitioner controlled by the main DAMS software page.  Since this module has the 
capability to collect massive amounts of data, the data will be stored directly to disk, each 
measured position will be stored as a separate file containing the magnitude and phase data for 
the entire frequency range.   (See next page for file format examples)

Source Coordinate List 	 Specify a list of source position coordinates, an entire Az/El scan using 	
					     the primary positioner will be made for each pair of coordinates

Remote File Trigger		 In this mode, the software will monitor the c:\dams\command.txt 	
					     file , when the value in this file changes to a 1 , the software move the 	
					     Source positioner to the coordinate located in c:\dams\auxcoord.txt 	
					     and will perform an AZ/EL scan. In this mode the Coordinate list file is 	
					     NOT used!! 

Data Output Location	 Select a working directory where the log file wil be located, the 		
					     directory where the log file is located is also where all data filles will 	
					     be saved.  As noted earlier a file for each AZ/EL position will be made 	
					     containing all frequency informaiton for that position.

Status			   Displays the current operation being performed.

Multi-Positioner Automation



102Making Measurements

  

File Trigger Mode

File Triggering , Loop Mode, and Write to Disk

The DAMS Software can trigger a measurement and output the data to a file for external analysis 
the software can be triggered by writing a 1 to a certain file, upon a completed measurement the 
software will change the 1 back to a 0.  From the main page, 

Select System Options → Advanced Settings to display the menu below

Output to file	 For large measurements over 1,000,000 data points see following 	
				    page for the example data format and file naming conventions. 

Loop Mode		  This sets the DAMS to loop mode, this mode is useful for demo 	
				    displays or simply running the same pattern repeatedly.

File Trigger Mode	 Requires loop mode.  When this mode is enabled, after you
				    press any of the “begin measurement” buttons, the DAMS
				    software will monitor the file C:\command.txt.  When the 1 		
				    changes to a 0 the DAMS Software will execute a measurement 	
				    and write a 0 back tot he file when finished. 
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Individual Coordniate Files 

The automation module is designed to save the data directly to the disk instead of being 
plottable within the DAMS Software, this is because the DAMS software has a ~500K point limit 
and these measurements can easily exceed that value.                                      

C:\DAMS\coordlist.txt - Each row is a pair of tab delimited coordinates - the format is AZ  EL 

Exported File Contents:  
Format space/tab delimited:  
                             (Frequency(Hz)) (Linear Magnitude) (Phase)

Automation Module - Exported File Format
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Utilizing the Data Processing Features

Post-Measurement Data Manipulation
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Introduction

Use the Data Processing section to work with the data you collected after you make 
any Antenna Measurements. This feature allows complete control over the data 
including the ability to completely manipulate the data using a large set of math 
operators as well as compare the current antenna to another Antenna or a calibrated 
reference antenna. A complete set of plotting options allow you visualize your data in 
a multitude of  formats. This section of the manual will assist you with getting the most 
out of your Antenna Measurement System.  If you are not familiar with any of the terms 
mentioned in this chapter, please refer to the Software Overview.

Screenshot 

Post-Measurement Data Manipulation
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Saving & Loading Measurement Data Sets

All measurement data is stored in “data storage registers” and each data set consists of a group 
of four (4) data registers. These registers are used for storing and recalling data within the Data 
Processing feature and can be recalled or saved to disc at any time.  The register labeled “Active 
Register” will contain your current measurement or any loaded measurement.  All plots, graphs, and 
export features will be based off of this register, but is considered “temporary” and will not be saved 
to disc.  Any active register data to be saved must be placed into one of the four data registers. 

Once you enter the Data Processing section after making an antenna measurement, all of the 
measurement data is placed in the “Active Register”.  To save this data, click “Data Storage Reg 1”.  
The data will be placed into Data Storage Register 1 (and causes a red * to be placed next to that 
data register).  To save this data set to the hard drive, press “Save Reg 1-4 to disc”.

Data Storage Buttons	 All data in Active Register is stored to the storage area that you chose.

Recall Button			  All in that storage register will load into to the active register for viewing 		
					     or modification.

Load Reg 1-4 From Disc	 This button will load a set of 4 registers from the disc.

Save Reg 1-4 To Disc	 This button will save a set of 4 registers to the disc.

Clear All Registers		  This button will clear all data from registers 1-4.

  QUICK TIP:

After entering Data Processing, click 
“Data Storage Reg 1” immediately 
to keep original measurement data 
available.
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Introduction

Press any of the 3D buttons to view the “Active Register” data in 3D using MatLAB 
Viewing Interface.

Viewing 3D Azimuth Measurements

1.	 Ensure data is present in “Active Register”.  If there is no 		
	 data, recall data from one of the storage registers or make a 	
	 measurement. 

2.	 Click “View 3D AZ Plot”. 

3.	 Depending on the size of your measurement and the speed of 	
	 your computer, it may take up to two minutes for your 3D plot 	
	 to render on screen. 

Viewing 3D AZ/EL Measurements

1.	 Ensure data is present in “Active Register”.  If there is no 		
	 data, recall data from one of the storage registers or make a 	
	 measurement. 

2.	 You can only view one frequency at a time using the AZ/EL 3D 	
	 Plots.  When you press the “View 3D AZ/El” measurements 	
	 you will be prompted to choose which frequency to 		
	 view. 

3.	 Depending on the size of your measurement and the speed of 	
	 your computer it may take up to two minutes for your 3D plot 	
	 to render on screen. 

  QUICK TIP:   Amplitude Plot can get a reference of the frequency response for antenna.

Working With 3D Data 	

Rotate plot: 			   Tools → Rotate 3D 

Print plot:			   File → Print 

Label plot:			   Tools → Add → Text 

Save plot:			   File → Save (saved file compatible with MatLAB viewer only) 

Export plot as image:	 File → Export (exports BMP image)

Viewing & Working with 3D Measurements



109 Data Processing Features

Dynamic Polar / Amplitude Plots

The Polar and Amplitude plots allow you to view the Horizontal or Vertical sweep data over specific 
frequencies and/or elevations. The Polar and Amplitude plots have been combined to use the 
same control panel. Select the frequency and elevation (if applicable), and the data will be instantly 
displayed on the plot.  Click “Amplitude Plot” to view the amplitude plot (click again to close).

Instructions for Dynamic Polar and Amplitude Plots

1.	 In main Data Processing window, click on “Polar/Amplitude Plot”, revealing the 		
	 screenshot above. 
2.	 REG0 will be loaded automatically.  Use the REGx buttons to select different data 		
	 sets. 
3.	 Use the sliders to browse through the data set.
4.	 Set Lin/Log and DB/DIV separation values as desired.

  NOTE:	 If you have already calculated the path loss and applied it to the 		
			   antenna, keep this feature UNCHECKED.

5.	 Markers located in center of the plot can be dragged to different areas of the trace, 	
	 the resultant amplitude and angle differences are displayed in the large numerical 	
	 windows at the bottom.  
6.	 To export the current trace data, click “Export”.
7.	 To save entire plot with number labels, you must use Windows’ screen capture 		
	 function by pressing the “Print Screen” button on your keyboard.  Then paste the 		
	 image into an image editing program where it can be further labeled or printed. 
8.	 Click “Gain Plots” detailed instructions.

  NOTE:	 Advanced procedures such as working with dual trace plots are 		
			   discussed in the Advanced Techniques application note. 
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Introduction

After you have made your antenna measurements and have entered the Data Processing area, you 
may then import your Reference Antenna data and Path Loss data for the measurement.  This data 
can be directly applied to your measurement or you can be saved in it’s own register for later use. 

You can enter all of the gain values for a specific reference antenna into an appropriately formatted 
text document. The software will read and interpolate these values across the entire measurement 
frequency range of your measurement and place the values into the Active register, the calculator 
can now be used to apply the reference data to your register containing the original measurement 
data. See the REFhorn.txt file located in C:\DAMS.

Instructions

1.	 Make your antenna measurement and proceed to the Data Processing section. 

2.	 Store your measured data into REG1

3.	 Click “Import Reference”

4.	 Click “Load from notepad file” and select your reference data file. 

5.	 Wait until you see “Data loaded” and press “Continue”.

6.	 The “Import Reference” button is now green indicating that reference data is present.

7.	 Reference data can be recalled into the active register for additional operations but is not 		
	 required for basic gain transfer calculations.

8.	 If the path loss data has already been calculated you can now proceed with the Gain Transfer

  NOTE:	 See following page for example reference data.

Importing Reference Antenna Data
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Example Reference Data

Example is for a 1-18 GHz horn. 
Standard .TXT File
FORMAT:  frequency(in ghz) (tab) gain value in dBi

1		  6.7
1.5	 8.7
2		  7.3
2.5	 8.1
3		  8.9
3.5	 8.7
4		  9.6
4.5	 9.6
5		  8.7
5.5	 9.4
6		  9.4
6.5	 9.7
7		  9.6
7.5	 9.8
8		  10.4
8.5	 10.6
9		  11.3
9.5	 11.1
10		 11.6
10.5	 11.3
11		 10.9
11.5	 10.6
12		 11.6
12.5	 11.2
13		 11.7
13.5	 10.8
14		 11.2
14.5	 11.1
15		 12.2
15.5	 12.9
16		 12.5
16.5	 10.7
17		 9.8
17.5	 9.4
18		 9.3

Example Reference Antenna File
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Introduction

You can calculate the loss for the given distance between two antennas using the path loss calculator. 
This process is nearly the same as importing reference data. The instructions below will show you 
how to simply apply the path loss data to your measurement and save that data into a new register.  

Instructions 

1.		  Make your antenna measurement and proceed to the Data Processing section. 

2.		  Store your measured data into REG1

3.		  Click the “Calculate path loss” button

4.		  Enter your desired distance into the window and select your designator, the press calculate 

5.		  Wait until you see “Data loaded” appear and press “continue”

6.		  The “Generate Path Loss” button is now green indicating that path loss data is present.

7.		  Path loss data can be recalled into the active register for additional operations but is not 		
		  required for basic gain transfer calculations.

8.		  If the reference antenna data has already been imported you can now proceed with the Gain 		
		  Transfer or Gain Substitution module. 

		

Calculating & Applying Path Loss Data
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Introduction

This module calculates the efficiency of a spherically measured antenna, the TRP can also be 
calculated if the transmit power is known. 

For optimal efficiency measurements it is required to make a full spherical measurement with the 
reference antenna in both the horizontal and vertical polarizations (H+V Total Power). 

Prerequisites 

1.	 Calculated gain data must be recalled into the active register prior to running the efficiency 		
	 module.

2. 	 If Total Power data is desired, the calculated gain for  both polarizations must be located 	                                	
	 in Reg1 and Reg2 and the “Total Power” button can be used to combine both measurements. The 	
	 result will be stored to Reg3.

3. 	S22 (reflection data) must be stored in Reg4 if you wish to de-embed the data. 

Efficiency Measurements
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Multi-Trace Plots

Introduction

The DAMS Polar plot module includes an over frequency plot which is capable of 
multiple trace plots.  Once a multi-trace plot has been generated it may be exported to 
excel or plotted with GnuPlot.

Multi-Trace Polar Plots

1.		  Have your desired measurements in the proper registers.  Note: multiple registers are not 
		  required as you can also select different frequencies of the same antenna to compare.
2.		  Open the Polar / Amplitude Plot, default should be in dB.
3.  		 Set desired plot scale dB/Div.
4.		  Find the freq/register you wish to compare with the highest gain (this should be the first one as 
		  we will normalize to this max value).
5.		  Make sure Pen1 is selected.
6.		  Press the normalize button, which normalizes the plot to this maximum gain level.
7.		  Press the first hold checkbox to the left of the polar plot.
8.		  Change to Pen2. 
9.		  Select the next frequency/register for comparison.  
10.	 	 Press the second hold button.
11.	 	 Change to Pen3.
12.	 	 Select your next register for comparison. 
13.	 	 If desired, again select hold, then select pen 4 and load your last set. 
14.	 	 Press Excel Export / Report, if your data looks good, Press “SEND TO EXCEL” or use “Plot with 		
	  	 GnuPlot” and select the Multi-Trace check box.
15.	 	 If you wish to do another comparison, press the Normalize button again to undo normalization 
	  	 of the data.  Also uncheck all the hold boxes and change back to pen1 before continuing.
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Multi-Trace Over Frequency Plots

  NOTE:  	 It is important to follow these instructions in the exact order specified to ensure your 		
			   exported plots and data match.

1.		  Ensure your desired measurements are in proper registers.  Note: multiple registers are not 
		  required as you can also select different frequencies of the same antenna to compare.

2.		  Open the Polar / Amplitude Plot, default should be in dB.

3.  		 Press the “Over Frequency” Button, be sure 50% size is selected

4.		  Move the plot over the polar plot itself to have access to the sliders and pen settings.

5.		  Using the polar plot sliders, find the first AZ/EL position for which you want to display 

6.		  Ensure Pen1 is selected in the main polar plot window.

7.		  Press the first hold checkbox in the over frequency plot.

8.		  Change to Pen2. 

9.		  Select the next Az/El (or another register for comparison).  

10.	 	 Press the second hold button.

11.	 	 Change to Pen3.

12.	 	 Select your next register/point for comparison.

13.	 	 If desired, hold, select pen4 and load your last set. 

14.	 	 Press Excel Export / Report, if your data looks good.  Press “SEND TO EXCEL” or use “Plot with 		
		  GnuPlot”, where you will have the option to enter trace descriptions.

15.	 	 If you wish to do another comparison, press the Normalize button again to undo normalization 		
		  of the data.  Also uncheck all the hold boxes and change back to pen1 before continuing. 
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GnuPlot Polar and Amplitude Plots

Introduction

Certain measurement plots and data can be plotted using gnuplot which was installed 
with your software. Gnuplot produces multi-plot, publish quality plots.  Below is 
information on which sections of antenna measurement studio support Gnuplot 

2D Polar GnuPlot 

Beamwidth Lines (single trace only)  - Plots 3dB beamwidth lines on the single trace 
gnuplot. 

Multi-Trace - Check this box when you have multiple traces selected in the polar plot.

XY Amplitude - Cartesian XY plot of amplitude over rotation. 

CISPR 16-1-4 - Generates CISPR Compliant plots (requires data to be collected as 
specified in CISPR standard)
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Polar / XY plot examples

Certain measurement plots and data can be plotted using gnuplot which was installed 
with your software. Gnuplot produces multi-plot, publish quality plots.  Below is 
information on which sections of antenna measurement studio support Gnuplot. 

NOTE: Gnuplot will auto-sense whether a polar or over frequency plot is being 
displayed and display the appropriate menu!!  
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Over Frequency Plots (Launched from polar plot)

Over frequency plots follow all of the same procedures as the polar plot regading 
single or multiple traces.  The Over Frequency plot has the ability to change the trace 
descriptions, the default value is the AZ/EL position of the over frequency trace 
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Saving Plots

Currently the default format for direct save from the GnuPlot window is .EMF 
format , this is a vector format that can be opened by a number of graphics editing 
applications. 

		  To save a plot 
			   1. Right click the upper left icon of the plot 
			   2. Select Options → Save as .EMF 
			   3. Select the save location and press save.

Batch Plotting

Batch plotting will export a polar plot of every frequency in the dataset. currently the 
only directory that files will be saved to is C:\DAMS therefore it is important to move 
the files into a new folder to prevent the clutter of the C:\DAMS folder

Range Types

			   Range		 All frequencies between the start and stop frequencies		
			   CW		  Selects a single frequency			 
			   List		  Select a list of point with any spacing
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Measurement Calculator / Register Math Function

Introduction

Use this option to perform arithmetic operations on the measurement registers. For 
example if you make measurements on one antenna and wish to compare the results 
to another antenna at each point of rotation and each frequency. Or if you have a 
calibrated reference antenna an wish to normalize additional measurements to the max 
or min value of the reference antenna. Remember all measurement data is linear so 
you may want to “LOG” the data before doing math. If you select MAX or MIN then all 
measurement elements will be replaced with MAX or MIN. This creates a normalization 
reference if you do your math correctly.

Register Math / Calculator Screenshot

Understanding the Register Math Functions 

Measurement data is initially stored in the Active register when you leave the main 
software page and enter the advanced processing section. When you proceed to the 
Data Processing Feature you have a choice of 4 additional registers in which to store 
Reg0.

  NOTE:  Measurement format is:  dataReg0-4[Mag,Phase,(Hpos,Vpos),0/1,freq]

Each time you press the Reg calculator  =  sign the results are save to the Active 
Register. You can then save those results to any one of the 4 original Regs. Be sure to 
have saved the original to disc as it will be over written.

Math Functions

Linear	 When highlighted the Reg# to the right is to be used as S21 in vector 		
			   format arithmetic is performed using vector components

LinearMag	 When highlighted the Magnitude of Reg # to the right is to be Logged 	
			   (dB) and used as a scalar array in all arithmetic operations. The angle 		
			   information is remains in the original Reg# but is lost in the calculator.
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LOGmag	 When highlighted the Reg# to the right is to be used as 10LOG(S21^2) in scalar 		
			   format The frequency S21 angle information remains in the original Reg # but is lost 		
			   in the calculator.

^2 		  When highlighted the Reg# to the right is to be used in complex format and 			 
			   squared

SQRT	 When highlighted the Reg# to the right is to be used complex format ^(1/2)

Max		 When highlighted the Reg# to the right Maximum Linear value is to be used in all 		
			   matrix arithmetic. This provides a good way to normalize measurements. The  			
			   frequency S21 angle information remains in the original Reg# but is lost 			 
			   in the calculator.

Min		 When highlighted the Reg# to the right Minimum Linear value is to be used in all 		
			   matrix arithmetic. This provides a good way to normalize measurements. 			 
			   The frequency S21 angle information remains in the original Reg# but is 			 
			   lost in the calculator.

Constant	 Use the constant option to +-/* a constant to the first register set (left) This 			 
			   is useful when you wish to add level shifts such as 3dB for HV polarization 			 
			   measurements not accounted for anywhere else.

Clip Function

Use this to create a threshold level. A ZERO value clip causes software to ignore clipping and resume 
normal calculator mode.
For example lets say the you wish to not include data points smaller than some low level value such 
as <-50dBM. 

Enter the value -50 into the constant window Understanding the Register Math Functions and 
highlight “Clip”. This will operate on only the data from the first set (left of the +-*/). Any magnitude 
values LESS that the clip value will be set EQUAL to the clip value.
             

  NOTE:	 The plotting functions will be affected by the clip value. Use this to scale and expand 		
			   the plots. Notice also that the calculator can be used to change the plot scales from		
			   linear to log or to add offset to measurements.

		  TERM 1 MULTIPLIER	Works with
      	 LINEAR                        +,-
      	 linMag                        	+,-,*,/
      	 LogMag                      	+,-,*,/

		  TERM 2 MULTIPLIER
		  All functions above plus Constant 

	IMPORTANT:	 Not all combinations of math are possible. Ensure you have same size 			 
				    data array.
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Exporting Data for Howland N2F Software

N2F Software Compatibility

DAMS Antenna measurement studio can be used to collect an export spherical near 
field data to be processed using 3RD party N2F transform software. 

Exporting Calibration or AUT scan data for Nearfield Processing 

Make a spherical scan at your desired frequency range and axis resolution, you will need a scan at 
horizontal position and a scan at vertical calibration. Non Symmetrical axis resolution will generate 
an error in the Howland software but will still process data.  Store one polarization to REG1 and the 
Other polarization to REG2  Located under “Register Utilities” in the DAMS software you will find N2F 
data export, when this is selected you will be presented with the screen below:

N2F Data Export Screen  

1.	 Browse and select the export file location, .txt format is required 

2.	 Select your frequency to export

NOTE: Greyed out areas are mandatory / auto-filled  other fields are not required but can be viewed 
within the N2F software and are useful for making notes about the measurement. 
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Example .N2F File
Howland Wireless Test Lab  Ver: V5.02
Date: 3/19/2019
Time: 9:03:27 AM
File Name: C:\DAMS\n2fCHbalCal.txt
File Type: Single Frequency

Antenna Pattern Test
Network Analyzer Measurement
Measurement Mode: Relative
Calibration Standard Antenna: None
__________________

Device Under Test (DUT): Dut Antenna
DUT Test Position: Free Space

Test Type: Discrete Test
Test Duration: N/A
Test Comments: Comments

Axis2 VPOL Antenna: Enter
Axis2 HPOL Antenna: Enter
Axis1 Antenna: Device Under Test

Axis1 Equipment: HP8722
Test Frequency: 32000 Mhz
Output Level: Enter
Frequency Count: 11
Start Frequency: 25000 Mhz
Stop Frequency: 35000 Mhz

VPOL Equipment: HP8722
HPOL Equipment: HP8722
Network Analyzer Bandwidth: Enter
Frequency Dwell: N/A

Axis1 Name: PHI
Axis1 Start Angle: 0.000
Axis1 Stop Angle: 360.000
Axis1 Increment: 2.500
Axis1 Speed: N/A
Axis1 Dwell: 0.000 Sec

Axis2 Name: THETA
Axis2 Start Angle: 0.000
Axis2 Stop Angle: 165.000
Axis2 Increment: 2.500
Axis2 Speed: N/A
Axis2 Dwell: 0.000 Sec

******* Insertion Loss Measurement Results  ********
Network Analyzer Response Correction: OFF

                H-Pol   H-Pol   V-Pol   V-Pol
  THETA     PHI     Mag   Phase     Mag   Phase
  (deg)   (deg)    (dB)   (deg)    (dB)   (deg)
   0.00	   0.00	 -23.160	  -15.97	-49.198	  -10.83
   0.00	   2.50	 -23.142	  -18.10	-42.728	   -3.89
   0.00	   5.00	 -23.119	  -18.19	-39.318	   -5.44
   0.00	   7.50	 -23.273	  -18.65	-37.028	   -1.30
   0.00	  10.00	 -23.340	  -18.38	-34.946	   -4.35
   0.00	  12.50	 -23.385	  -18.40	-33.639	   -4.79
   0.00	  15.00	 -23.530	  -19.24	-32.099	   -4.50
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Exporting Peak Gain data for Nearfield calibration / correction 

Similar to the reference import format for the DAMS software, the N2F software requires a specific 
format for peak gain data, this data is used for the substitution style calibration of the N2F software 
this file is used in conjunction with the antenna that you used for the channel balance measurement 
/ calibration.  

N2F Peak Gain Export 

1.		  Load or recall the desired data set into the DAMS Software, this data will contain over-			 
		  frequency data for your calibrated antenna.

2. 		  Load the polar plot and select “Over Frequency Plot’.

3. 		  Navigate to the desired AZ/EL position which contains the Peak or calibrated gain data. While 		
		  the over frequency plot is displayed, press the N2F export button in the main polar plot.
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Example .N2F Peak Gain File
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Exporting Data

Export Methods

The DAMS software offers you 2 ways to export your data. We refer to them as the 
“REGISTER EXPORT” which will export your entire measurement set over the entire 
horizontal/vertical axis and over frequency and the “SINGLE FREQUENCY” export which 
can be found in the “Polar and Amplitude” plot function in the Data Processing section. 

Single Frequency Export Instructions

Available in the Polar/Amplitude Module.

After loading the Polar Plot, select desired frequency and click “Export Data”.  You will 
be prompted to select a file name. 

EXPORTED DATA EXAMPLE

!	 Saturday July,16  2005
!	 Freq = 896MHz		  Elevation = 0
!	 Azimuth  		  S21mag   	 S21ang       
	 0			  0.0169    	 86.8     
	 5			  0.0146    	 81.6     
	 10		  0.0151    	 82.9     
	 15		  0.0141    	 81.4     
	 20		  0.0135	 81.9     
	 25		  0.0129	 82.4     
	 30		  0.0123	 82.8     
	 35		  0.0114	 84      

Register Export Screenshot

This feature is located in the Advanced Processing window under “Register Utilities”.



127 Data Processing Features

Register Export Instructions 

1.	 Under the “Register Options” pull-down located in the data processing section, click “Register 		
	 Export” button and select one of your 4 data registers that you would like to 				  
	 export. 

2.	 Verify the parameters are correct and select your desired frequency range to export. 

3.	 Press the Export button and choose the file to export to. 

  NOTE:	 Some programs have a limit on the number of columns that they can input.  If 		
			   importing fails, try reducing the number of frequencies that are exported. 
							     

Example Exported File 

 Azimuth	       Elevation		  Freq.1 Mag	    Freq.1 Phase           Freq.2 Mag              Freq.2 Phase

							     

Importing Register Export Data into Excel

The data generated by the Register Export feature is directly importable into EXCEL by following the 
steps below.

1.	 Open Excel.  Select File → Open.  In the file type pull-down menu, select “Text Documents (*.txt)” 		
	 to easily locate your file and click “Open”.

2.	 In the box labeled “Original data type”, select “Fixed Width” and click “Finish”.  Additional options 		
	 can be set but are not required to complete import.

3.	 Your data should open segregated into individual cells within a new Excel Workbook.
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Introduction   

The Report function is located in the Polar Plot feature. 2 Methods are offered 
for making a printable measurement report including a polar plot and antenna 
information. After you have plotted your antenna at the desired frequency and applied 
any other settings (DB, Markers, scale, etc) press the Printable Report button. 

Excel Export Screenshot

Features & Options

Report and Data		  Generates a two-page Excel spreadsheet containing plot 		
					     with trace details on page one and actual trace data on 		
					     page two.

Report Only			   Only exports the image with trace details such as min., max. 	
					     or avg.

Excel Report - Polar Plot and Over Frequency
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Data Only			   Exports a multi-column sheet of all displayed trace data
 
Flip Rows			   Should you want to reverse the data plotting direction, this will reverse 		
					     the direction of the measurements made.  (Example: 0-360 becomes 360-0)

Include Efficiency Box	 If the Efficiency function has been used this option becomes selectable.		
					     You may choose to export the efficiency trace numbers along with the 		
					     standard trace data.

Export Types Examples

Sheet 1 - Plot Image with Trace Details

(Continues next page...)



130Data Processing Features

Export Types Examples (Continued)

Sheet 2 - Trace Details

Excel Sheet Settings - For Excel 2013 and International Customers

Excel 2013 Customers: In Excel, click file then options, change the default number of sheets to 3

International customers:  You may experience issues with exporting data to excel due to default 
sheet names in a foreign language.  We have added a feature to enter the sheet name as shown 
below.  This is located within any of the Excel Export menus.  Once it has been changed, it will save 
with the DAMS software settings.
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Group Delay Function

Group delay is the derivative (slope) of the transmission phase angle.  For passive 
circuit elements, the group delay is linear and may be calculated from two 
measurements.  It is important that the ratio of the frequency delta-wavelength is less 
than the physical distance between the measurement.   If this is not the case, either the 
frequency resolution must be increased or the delay will need to be integer-scaled. The 
scale integer is INT(d/wavelength).  Wavelength is the specific wavelength associated 
with the difference frequency (or step frequency).  Periodic spikes will occur in the 
group delay plot.  Non-periodic spikes represent the Multipath or some other source 
of distortion.

Be advised this software does not perform vector corrections for free space 
measurements. The corrected group delay is only applied to the display.  Use the 
“EXPORT” button on the display to save the display values to disc.

	IMPORTANT:	 If you have made measurements and saved them to the disc (or into a Data 		
				    Register), they will NOT be corrected for system delay but WILL be corrected 		
				    for system loss. We advise noting this in your file document item to 			 
				    avoid incorrect displays, or re-save.  To correct the group delay (locally) check 		
				    the radial “Correct for system delay” (on the left).  The plots will automatically 		
				    update allowing you see both the corrected and uncorrected profiles.

Group Delay Screenshot





133

Troubleshooting & Service

General Problem Solving & Maintenance Info
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Power supply light 
on but controller is 
not on

Controller light is on 
but positioner does 
not move

Only one axis is 
moving

Wrong axis moving

ERROR: Driver for 
[instrument] not 
found

Out of memory

Matlab Error

Excel Export Crashes

Power supply not connected 
correctly, Power Switch is not 
turned ON?

USB cable not connected?  
Driver not installed? Improper 
port selection in DAMS 
software?

Loose cable connection? 
Controller error?

Reversed cable connections? 
Improper positioner settings?

Instrument not configured 
properly in Agilent VEE 
Runtime I/O configuration?

Measuring with too many 
frequency points for physical 
resolution settings?

Is Agilent VEE Pro Runtime set 
to run as administrator?

Is Excel installed on PC?
Are there are least 3 sheets?
Do sheet names shown in 
DAMS software match excel?

Check the above items and if all is correct, please 
contact us for service.

Check all connections and reboot.  Open “positioner 
settings” and click “Find”.  If controller not found, 
go to: Control Panel → System → Device Manager 
→ COM Ports.  Verify the DAMS Platform Controller 
is listed.  If not, follow the “USB Driver Installation & 
Configuration” for x000 Series or “x100 USB Driver 
Installation & Configuration” for x100 Series.  

With the controller off, disconnect and then reconnect 
yellow cables. 

Verify all positioner settings within the software and/or 
reverse yellow cables.

Read instrument configuration instructions. Contact us 
if problem persists.

Reduce the number of points, or limit the AZ / EL 
extents.  

Open C:\program files (x86)\Agilent\Vee Pro Runtime, 
right click veerun.exe and select properties, click the 
compatibility tab and select “RUN AS ADMINISTRATOR”

In Excel, click file, options and change default number 
of sheets. 
 
In DAMS software open excel export and click sheet 
names, verify the names match the default sheet names 
in excel.

General System Troubleshooting

Problem Possible Causes Solutions

If you are experiencing any of the above problems or an unlisted problem and cannot determine the 
cause, please do not hesitate to contact us.  We are happy to assist in resolving any issues.
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Warranty Information

Diamond Engineering’s Antenna Measurement Systems are guaranteed from one to three years on 
parts and labor from the time it was received by you.  If there is an issue with the product please 
send us a picture or write a very detailed description of the problem.  If we determine that you have 
a faulty unit or a bad part, we will ship you a replacement part or unit along with a pre-paid self-
addressed box to send the defective unit back.

Replacement Parts

If you ever need a replacement part for your unit, please call us or e-mail us for pricing information. 
Most repairs are covered under warranty except for damages resulting from obvious abuse or misuse 
of the product.

Contact Information

Distributed by: 

Reliant EMC LLC 

+1 ﴾408﴿ 916‐5750 

info@ReliantEMC.com 

www.ReliantEMC.com 

Warranty, Replacement Parts & Contact Information


